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Chapter 1
OVERVIEW OF THE DAS STUDIO 3 INTERFACE

DAS Studio 3 software lets you configure Data Acquisition Units (DAUs), network switches, recorders and ground
stations in an integrated environment. A multi-threaded design is used which utilizes multi-core processors to
improve performance.
DAS Studio 3 lets you set up a system by creating or opening XidML® 3.0 configuration files. 

Features
• Discovers, configures, manages and programs DAUs, network recorders, switches and ground station cards

• Real-time display (Quicklook) and playback of data recorded on CompactFlash® cards

• Validates hardware

• Hardware health status checking

• Optimized for multi-core platforms

• Functionality can be extended through plug-in applications

• Simple and intuitive interface

• Scalable to tens of thousands of parameters

• Supports XidML 3.0

System requirements

Minimum recommended hardware requirements

Item Description

Processor 2.4 GHz Intel® Dual Core

Hard-disk 80 GB1

1. For a project configuration with multiple chassis, a PC with Windows 10, 64-bit is recommended.

RAM 8 GB

Screen 1024 x 768

Graphics card Intel® G31/G33 Express Chipset Family2

2. If using GS Works we recommend using one of the following graphics cards: nVidia GeForce 6xxx+; 
nVidia Quadro 3xxx Video (PCI Express16).

PCI slot per board 32-bit PCI slot 3

3. Required if using a ground station board.



Quick Access 
Toolbar

Contains some commonly
used commands from the
ribbon (File/Tools) menus.

Save As
Saves the 
configuration file 
to a new name. 

Discover (page 47)
Discovers hardware 
and generates a 
configuration file with 
default settings and 
parameters. 

Open
Opens an 
existing 
configuration 
file.

Save
Saves the current 
configuration file.

File menu

New
Creates a new 
configuration 
file.

Navigator (page 57)
The Navigator tree view displays the 
system’s instrument hierarchy.
The Navigator shows connected hardware, 
channels and attached links allowing you to 
see at a glance how the system is 
configured.

Applications menu
The applications in this menu vary by 
software release (page 189). 

Application Bar
All the items in the File 
menu are also available 
in the Application Bar.

Package 
Generator 
(page 89)
Package 
generation 
wizard

Status (page 75)
Displays the status 
of the hardware in 
the configuration 
file.

Tools menu

Verify (page 65)
Verifies that the 
configuration can 
be realized on the 
instrumentation.

Calibration 
Fetcher (page 85)
Retrieves 
calibration data 
from connected 
hardware

Program 
(page 65)
Programs the 
hardware 
defined in the 
configuration 
file.

Bridge 
Balancer 
(page 81)
Automated 
balancing/
nulling tool

IP Conflict 
Checker 
(page 77)
Checks for IP 
conflicts on 
network

TimeSeeder 
(page 185)
Sets the time 
on a battery 
backup time 
module

Options (page 5)
Configure DAS Studio 3 
UI and programming 
options 

IP Address 
Programmer 
(page 69)
Updates IP 
addresses of 
network devices

Parameter 
Search 
(page 187)
Finds parameter 
usage in a 
configuration

XDefML 
Instrument 
Import (page 14)
Import XDefML files 
to Instruments 
Palette

X-Report 
(page 255)
Generates 
reports from 
XidML 3.0 
files



Adding components 
Components are added through four component palettes:
Instruments Palette (page 159)
Links Palette (page 173)
Packages Palette (page 177)
Parameters Palette (page 179)
These palettes are accessed through right-click context 
menus from the Navigator and Editor.
An additional palette for adding algorithms is accessed 
from the Settings tab:
Algorithms Palette (page 154)

Editor tabs
The Editor lets you view and edit 
settings and configuration 
documentation and is comprised of the 
following tabs:

Settings (page 93)
Provides an overview of the system's 
settings.
Processes (page 147)
Provide an overview of the processes 
defined in the system.
Packages (page 121)
Provides an overview of the packages 
defined in the system.
Algorithms 
Provides an overview of the editable 
algorithms. (page 151)
Documentation (page 157)
Provides a documentation overview of 
the system.

The Editor is context sensitive and is 
controlled by the active node in the 
Navigator.

Parameters editor (page 183)
Displays all parameters in the configuration 
file.
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Supported operating systems 

Supported character set
DAS Studio 3 supports the U.S. English character set for naming in all instances including instruments, packages,
and parameters.

Illegal characters such as the following must not be used:

Supported modules
For a list of modules that are supported in DAS Studio 3, see the DAS Studio 3 data sheet.

Registering for technical updates
Curtiss-Wright issues a monthly FTI bulletin, which provides updates on software versions and documentation
changes. To register for this Technical Information Bulletin, contact Curtiss-Wright support (acra-
support@curtisswright.com).

Getting help and support
Please provide details of any hardware or software problems you have to Curtiss-Wright support (acra-
support@curtisswright.com).

Operating system

Windows® 10 32-bit and 64-bit Professional or higher English

Windows 7 32-bit and 64-bit Professional or higher English

Windows 7 32-bit and 64-bit Ultimate or Enterprise and language packs English

Character Corresponding XML string

: &#58;

, & apos; 

< & lt;

> & gt;

& & amp;

mailto:acra-support@curtisswright.com
mailto:acra-support@curtisswright.com
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Chapter 2
OPTIONS - CONFIGURE UI AND PROGRAM OPTIONS

The DAS Studio 3 Options dialog box enables you to configure a number of options including program, display and
import. 

Figure 1: Options overview

Using the DAS Studio 3 Options dialog box
The DAS Studio 3 Options dialog box enables you to configure the UI and set whether programs such as Serial
Number Synchronizer or MCS are automatically run before programming or verifying are carried out. 
On the File menu, click Options.

The DAS Studio 3 Options dialog box appears.

 
This chapter describes the following tabs in the DAS Studio 3 Options dialog box:
For guidelines on settings to use with small screens, see “Recommended settings for low screen resolutions” on
page 16.
• “Program and Verify” on page 6



6    DAS Studio 3 User Manual (SW/BK/0015 | 13 Sep. 2021)

2

  

• “Program” on page 7

• “Display” on page 7

• “General” on page 8

• “IENA Package Defaults” on page 9

• “iNET-X Package Defaults” on page 9

• “Chapter 10 Package Defaults” on page 10

• “Import” on page 10

• “Settings Tab” on page 11

• “Packetizer Settings” on page 11

• “MCS General” on page 12

• “XDefML” on page 13

• “Instrument Import” on page 14

• “Importing Options settings from a previous DAS Studio installation” on page 14

• “Saving your changes” on page 15

Program and Verify

The following Program and Verify options are available:
 •  Run Validation - A pre-compilation validation check. Checks for clashing IP addresses, DAU ids, Ethernet 

packet stream identifiers and DAUs missing controllers.

 •  Run MCS - When selected, Multi-Chassis Scheduler (MCS) runs before programming or verifying. The 
MCS is used to generate packetizer packets in a chassis and transport packets in multi-chassis systems.

 •  Save MCS - When selected, changes made by the MCS and serial number synchronizer are saved to the 
XidML file.

 •  Compile Parallel - This is only recommended for large multi-chassis systems. Each chassis is processed in 
parallel to reduce verifying and programming times.
The recommended PC requirements for parallel compilation are a quad core processor and 8 GB of RAM.

 •  Stop on default calibration warnings - When selected, programming or verifying stops if default 
calibration is used for the module.
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Program

The following options are available:
 •  Synchronize serial number and fetch calibration - When selected, Serial Number Synchronizer and 

Calibration Fetcher are run before programming. (See “Serial Number Synchronizer” on page 251 and 
“Using Calibration Fetcher” on page 85).

 •  Stop on serial numbers errors - When selected, programming stops if there are synchronizer errors.

 •  Stop on calibration errors - When selected, programming stops if there are calibration errors.

Display

The following options are available:
 •  Font Type - Click the drop-down menu to choose Default, Arial, Arial Narrow or Agency FB. Arial Narrow is 

recommended for low screen resolutions.

 •  Local context only - Select the check box to display immediate content from the navigator in the editor 
tabs. Contents of child instruments will not be shown.



8    DAS Studio 3 User Manual (SW/BK/0015 | 13 Sep. 2021)

2

  

 •  Navigator Part Reference Style - Select the display style to control how instrument part references are 
displayed in the navigator. None hides the part reference; Truncated removes the first three letters and 
forward slashes; and Standard displays the full part reference. None or Truncated is recommended for low 
screen resolutions.

 •  Show Settings/Processes/Packages/Algorithms/Documentation Tab - Clear the check boxes for any 
tabs you want to hide.

 •  Show Parameters Control - Clear the check box to hide the Parameters control.

 •  Show Status Bar - Clear the check box to hide the Status bar.

 •  Show filter in column headers - Clear the check box to hide the filter in column headers. Recommended 
for low screen resolutions.

 •  Show setting group titles - Clear the check box to hide group titles in the Settings tab. Recommended for 
low screen resolutions.

 •  Hide empty editor tabs - Select the check box to hide empty editor tabs. Recommended for low screen 
resolutions.

 •  Allow duplicate IENA keys per channel - When selected, allows the same IENA key to be used in multiple 
packages on a channel in an instrument. This a single channel restriction; the same IENA key cannot be 
reused across different channels or instruments.

 •  Range or Gain and Offset - For analog modules: choose Range to only display minimum and maximum 
range columns; choose Gain and Offset to only display gain and offset columns; choose Both to display all 
four columns. This setting does not affect temperature or digital modules.

 •  Tab zoom - Select the check box to allow resizing of content in editor tabs. Recommended for low screen 
resolutions.

General

The following options are available:
 •  Enable Modes - When selected, allows configuration of the extra modes in multi-mode instruments. For 

further information, contact Curtiss-Wright support (acra-support@curtisswright.com).

 •  Prompt to load last configuration on startup - When selected, you are prompted on startup to load the 
previously used configuration.

 •  Backup configuration - When this check box is selected, a backup file (.autobackup appended) is 
automatically created in the Backup folder under DASStudio. If DAS Studio 3 terminates unexpectedly, you 
are prompted on restart to open this backup file.

 •  Backup interval in seconds - When Backup configuration is selected, then the configuration file is 
backed up at the interval you specify here. 
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IENA Package Defaults

 
The following options are available:

 •  IENA Key - Defines the IENA key when adding an IENA package from the palette.

 •  IENA Status - Defines the IENA status when adding an IENA package from the palette.

 •  Service Port - Defines the IENA source port when adding an IENA package from the palette.

 •  Destination MAC Address - Defines the destination MAC address when adding an IENA package from the 
palette.

 •  Destination IP Address - Defines the IENA destination IP address when adding an IENA package from the 
palette.

 •  Destination Port - Defines the IENA destination port when adding an IENA package from the palette.

iNET-X Package Defaults

 
The following options are available:

 •  Stream ID - Defines the iNET-X packet identifier when adding an iNET-X package from the palette.

 •  Source Port - Defines the iNET-X source port when adding an iNET-X package from the palette.

 •  Destination MAC Address - Defines the destination MAC address when adding an iNET-X package from 
the palette.

 •  Destination IP Address - Defines the iNET-X destination IP address when adding an iNET-X package from 
the palette.

 •  Destination Port - Defines the iNET-X destination port when adding an iNET-X package from the palette.
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Chapter 10 Package Defaults

 
The following options are available:

 •  Source Port - Defines the Chapter 10 source port when adding a Chapter 10 package from the palette.

 •  Destination MAC Address - Defines the destination MAC address when adding an Chapter 10 package 
from the palette.

 •  Destination IP Address - Defines the Chapter 10 destination IP address when adding a Chapter 10 
package from the palette.

 •  Destination Port - Defines the Chapter 10 destination port when adding a Chapter 10 package from the 
palette.

Import

The following options are available:
 •  Save source in parameter documentation - Select the check box to add the import file name to all 

imported parameter's long description. The parameters control displays this information in an extra column.

 •  Use import file name for link - Select the check box to include the name of the file in the link when 
importing a link from an external file. See following example with link imported from mill-9 xidml file.

 •  Add link to packages and parameters - When the check box is selected the imported link name is added 
to the name of all packages attached to the link and all parameters in these packages.
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 •  Use KAD/ARI/001/B link settings - Select this check box to update the channel and the link documentation 
when importing a link using the Add with Connections button on a KAD/ARI/001/B. 
The updates are:
1. Update the speed setting of the channel to FAST when the imported link speed setting is HIGH.
2. Update the document long description of the imported link with the release setting name and value of the 
imported link, for example Release : 000145.

Settings Tab

 
The following options are available:

 •  Rename link - Select the check box to allow links to be renamed or created in Settings tab tables. 

 •  Update parameter names after renaming analog links - Select the check box to allow parameters on 
analog channels to follow the name of their channel’s link. 

Packetizer Settings

The following options are available:

Link name Parameter name
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 •  ShortPacketNaming - MCS generated packages have short or long names. For example, the short form is 
KADMEM004B4GMSP while long is MyKAD_MEM_004_B_4GMemoryStoragePackage.

 •  UseLinkNameForPacketizer - When selected, the MCS uses the name of the link for the auto generated 
packetizer packages.

 •  DARv3_DEST_PORT - Reserved.

 •  CH10_DEST_PORT - The MCS use this destination port address value in auto generated Chapter 10 
packetizer packages.

MCS General

The following options are available:
 •  MaximumRecorderPackageRate - Restricts the rate of MCS generated recorder packages. Value is in 

hertz.

 •  MaximumTransportPackageRate - Restricts the rate of MCS generated transport packages. Value is in 
hertz.

 •  PropagationDelay - Used to calculate the latency through the system if there is no latency information on 
the devices in the system. Value is in microseconds.

 •  TransportType - Defines the transport package type of MCS generated transport packages.

 •  IENA_STATUS - Defines the default status value in MCS generated IENA transport packages.

 •  IENA_ENDWORD - Defines the default end word value in MCS generated IENA transport packages.

 •  IENA_SOURCE_PORT - Defines the default source port in MCS generated IENA transport packages.

 •  IENA_DESTINATION_PORT - Defines the default destination port in MCS generated IENA transport 
packages.

 •  MinimumTransportPCMBitsPerMinorFrame - Defines the minimum PCM package size in bits for MCS 
generated PCM transport packages.
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 •  MaximumTransportPCMBitsPerMinorFrame - Defines the maximum PCM package size in bits for MCS 
generated PCM transport packages.

 •  UniqueIDsForMemoryPackages - When selected, compilation fails when memory packages do not have 
unique package identifiers. For example, if the memory package is iNET-X, it must have a unique stream 
identifier and cannot use an existing stream identifier.

 •  PacketizerHeaderType - Defines the package header type of MCS generated packetizer packages.

 •  CopyMasterPCM - Reserved.

 •  MaximumTransportPCMBitRate - Restricts the rate of MCS generated PCM transport packages. Value is 
in bits per second.

 •  INETX_SOURCE_PORT - Defines the default source port in MCS generated iNET-X transport packages.

 •  UNIQUE_DEST_IP-FOR-TRANSPORT - Forces MCS generated Ethernet transport packages to have 
unique destination IP addresses. 

 •  Transport_Packet_Destination_IPAdress - Defines the default destination IP address in MCS generated 
transport packages.

XDefML

The following options are available:
 •  XDefMLCustomFolder - Reserved.
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Instrument Import
This setting is used to facilitate adding instruments to the New ACRA Component library (see “Adding new
parameters from the New ACRA Component library” on page 124).

The following options are available:
 •  Default Instrument Import Folder - Type the path to the folder which you want to use for storing instrument 

configuration (XDefML) files for the XDefML Instrument Import tool. After you save and restart DAS Studio 3, 
this folder is the default when you use the XDefML Instrument Import tool. Note: If you do not set a default 
folder, you can still browse for XDefML files using the XDefML Instrument Import tool.

Importing Options settings from a previous DAS Studio installation
You can import settings from a previous installation using the Import button. 
1. Go to the tab you want to import setting to and then click the Import button.
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2. Browse to the DASStudio installation folder you want to import settings from and then click OK.

The Option settings that will be changed are displayed.

3. Click OK to import the settings.

The imported settings are applied.

Conditions for importing
The following conditions apply when importing options.
• The folder you select to import options from must contain kSetup.exe, otherwise an error message displays.

• If there is no option to import, a message is displayed.

• Only tab options in both the current version and selected version can be imported.

Saving your changes
Click Save when you have finished making changes. You are prompted to restart DAS Studio 3. 
Restart DAS Studio 3 to guarantee all changes are applied.

NOTE:  These are global settings and are used for all configurations until you change them or until you install a 
newer version of DAS Studio 3.
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Recommended settings for low screen resolutions
The following Display settings are recommended if your screen resolution is at a low setting such as 800 x 600:
• Font Type - Arial Narrow

• Local context only - Enabled

• Show Status Bar - Disabled 

• Show filter in column headers - Disabled

• Show setting group titles - Disabled

• Hide empty editor tabs - Enabled

• Tab zoom - Enabled

When Tab zoom is enabled, a drop-down menu for each tab is
available for setting the zoom. 

To set the zoom, move the cursor over the tab header text and use
the mouse wheel to zoom.

You can also click (or right-click) the drop-down arrow and then
select the zoom you want.

If only using a keyboard, use the tab key until the drop-down arrow is
active, and then use Ctrl -/+ on the keyboard to zoom.
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Chapter 3
EXAMPLE - CREATING A BASIC CONFIGURATION 

This section introduces the main features of DAS Studio 3, such as adding instruments, links, packages and
parameters to a new configuration file. 
It is divided into the following two sections:
• “Network example” on page 18

• “PCM example” on page 28
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Network example
The following figure shows an example where a sine wave is sampled, packaged, and transmitted via Ethernet to a
PC. Quicklook or GS Works can then be used to view the data. The illustration explains the concepts of links,
instruments, packages, and parameters. The illustration also shows how they are described in the Navigator and
Editor of the GUI.

Figure 2: Hardware as shown after configuration complete

Opening and saving a new file
In a configuration file you can manually create the various elements which make up your data acquisition system,
for example, chassis, recorders, and switches. You then use this configuration file to manage and program these
elements. If you have more than one system, you can manage multiple systems within one configuration file or
create multiple configuration files. An alternative to manually creating the elements of a configuration file is to use
the Discover tool. For more information on discovering Curtiss-Wright hardware, see “Using Discover” on page 47.
To manually add instruments, first prepare a new configuration file.
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1. Open DAS Studio 3.
A new XidML® 3.0 file named NewConfiguration.xidml is automatically created.

2. On the Quick Access Toolbar or the File menu, click Save As, choose a location and then specify a name for 
the new configuration, such as BasicConfiguration.xidml.

Adding instruments
Instruments such as PCs, chassis and switches are added from the configuration node, BasicConfiguration.xidml.
(The configuration node is referred to as the overview node, because other components such as instruments and
links appear under it.)

NOTE:  You must add all of the physical components of your data acquisition system to your configuration file 
before attempting to connect them. For information on connecting these components, see “Connecting 
instruments” on page 21.

1. To add a PC, click the Click here to begin button in the Navigator.

Instruments Palette opens. For information on Instruments Palette settings, see Table 11 on page 159.

NOTE:  Palettes are context sensitive and are driven by the context they are called from; for example in the 
Navigator, the selected node is the context.
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2. On the PC tab, select a PC and click Add. 
The overview node and the PC are added in the Navigator.

3. To add a chassis, do one of the following:

 •  Select the overview node and then click the Add Instrument + button.

 •  Right-click the overview node and then click Add Instrument.

Instruments Palette opens.

4. On the DAU tab, select a chassis and click Add.
The chassis is then added under the overview node.

For information on working with instruments, see “Renaming instruments and links” on page 60, “Removing
instruments” on page 61, “Renaming instruments and links” on page 158, and “Selecting instruments” on
page 161.

Overview node
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Adding modules to instruments
Instruments such as modules and PCI cards are added to empty slots of a chassis or PC.
1. Expand the chassis node.

Empty slots appear under the chassis indicating where modules can be added.

2. To add a controller module to the chassis, do one of the following: (A controller module can only be added to 
slot 2.)

 •  Right-click empty slot 2 and then click Add Instrument. 

 •  Select empty slot 2 and then click the Add Instrument + button.

 •  Double-click empty slot 2.

Instruments Palette opens. For information on Instruments Palette settings, see Table 11 on page 159.

3. Select a controller module, such as a KAD/BCU/140, and click Add. 
The controller is added to slot 2 of the chassis.

4. To add an analog module, right-click an empty slot and then click Add Instrument. (You can also select an 
empty slot and then click the Add Instrument + button, or you can double-click an empty slot.)
Instruments Palette opens.

5. Select an analog module, such as a KAD/ADC/109/C/S1, and click Add. 
The module is added under the chassis node.

6. Run Serial Number Synchronizer (see “Serial Number Synchronizer” on page 251) and then run Calibration 
Fetcher (see “Using Calibration Fetcher” on page 85).

Connecting instruments
Instruments are connected using the Connect dialog box. Links represent the physical connections between
channels on instruments in a system (such as power connections, programming links, and links for transmitting
data). The Connect dialog box simplifies the connection process by showing a list of the channels that the channel
selected in the Navigator can be connected to.
In this example, a PC is connected to an Ethernet DAU using the Connect dialog box. The Connect dialog box
adds an Ethernet link between the PC and the controller module in a chassis.
1. Expand the PC node and then expand the Bi-directional node.
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2. Right-click the Ethernet node and then click Connect. 

The Connect dialog box appears.

For more information on linking, see “Connecting instruments” on page 174. 

3. Select the Ethernet channel node under MyKAD_BCU_140 and then click Connect.
The Connect dialog box creates a link and attaches it to the two instruments. The navigator context 
determines if the source or destination channel is shown in the Packages tab where packages can be added.
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Adding packages to an existing link or connected channel
After links have been added or channels connected, packages can be attached to them. 

NOTE:  Packages can be added to channels without the need for a link to be created. The Packages tab automati-
cally creates the link when required.

1. Select the channel in the Channels pane of the Packages tab.

2. Do one of the following:

 •  In the Navigator, right-click the link where you want to import the package to and then click Add/Import 
Package.

 •  Click the Import Package button in the Package Properties pane.

Packages Palette opens.

3. On the iNET-X tab, select a package, such as MyPlacediNET-XPackage (this is a transmission package, and 
is empty by default), and then click Add. 
For information on settings in the Packages Palette dialog box, see Table 14 on page 177.
The package is added to the Package Properties pane. 
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During editing, if an error exists, a red box indicates the field that needs correction. Move the mouse pointer 
over the field to see a tooltip on how to correct the issue.

For more information on adding packages without first creating links, see “Adding packages from the Navigator” on
page 60. For information on working with packages, see “Selecting packages” on page 178.

TIP!    You can make various changes to Package Properties values. Examples of possible edits are as follows 
and shown in the following figure:

 •  Rate (Hz) - the rate has been changed to 50.

 •  Destination IPA - in this field the destination IP address has been manually entered. 
If the IP address is multicast (as shown), then the destination MAC is automatically calculated.
If the IP address is unicast, then it is required to enter the destination MAC manually

 •  Destination UDP Port - a destination port number has been changed to 1023.

Figure 3: Editing package properties

Mouse over 
tooltip
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Adding parameters
After defining a package, you can specify parameters for package data on the Packages tab, as described in this
section. For information on adding parameters using default parameter names, see “Adding parameters with
default names” on page 99.
1. In the Placed Data pane, click the Place Parameter button.

Parameters Palette opens.

NOTE:  When working with transmission packages, for example MyPlacediNET-XPackage, only parameters 
that can be sourced from the chassis are available for placement. If the package is an input to a chas-
sis, for example a message on a bus monitor module, then new parameters are added to the package 
to indicate parameters of interest from the package being received. Parameters added in this way are 
then chassis source parameters that can be placed in other transmission packages.

2. From the This File library, select all the analog parameters and then click Add Reference. 
The parameters listed in the This File library are all the available parameters in the configuration. Parameters 
already placed in the package are not displayed. For more information on settings in the Parameters Palette, 
see Table 15 on page 179.
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The parameters are added to the overview grid and the Content table.

TIP!    You can make changes by clicking in a cell or field and changing the value accordingly. (You can only edit 
cells and fields that are white.) For example, you could change the Occurrences for each parameter to 2. 
The Occurrences and the Rate of the package combine to determine the rate of the parameter. Where the 
package Rate is 50 and the parameter Occurrences is 2, the rate of these parameters is therefore 100Hz in 
this package. For more information on working with parameters, refer to the following sections:

• “Disconnecting parameters” on page 98

• “Adding existing parameters from the This File library” on page 123

• “Adding new parameters from the New ACRA Component library” on page 124

• “Setting multiple parameter placement preferences” on page 128

• “Removing (un-placing) parameters” on page 130

• “Reading package tags” on page 148

• “Using Parameters” on page 183 

• “Changing parameter settings” on page 184.

Overview 
grid

Content 
table

Click to rename parameters
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Network example summary
The following figure shows our completed example of a basic configuration with the instruments, channels, links,
packages, and parameters added. In a setup with hardware connected, you would then configure module settings,
run both Serial Number Synchronizer (see “Serial Number Synchronizer” on page 251) and Calibration Fetcher
(“Using Calibration Fetcher” on page 85), and then program the hardware as shown in “Programming
instrumentation” on page 66.

Figure 4: Basic configuration packages tab
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PCM example
The following figure shows an example where a sine wave is sampled, packaged, and transmitted via PCM to a
PC. Quicklook or GS Works can then be used to view the data. The illustration explains the concepts of links,
instruments, packages, and parameters. The illustration also shows how they are described in the Navigator and
Editor of the GUI.

Figure 5: Hardware as shown after configuration complete

Opening and saving a new file
In a configuration file you can manually create the various elements which make up your data acquisition system,
for example, chassis, recorders, and switches. You then use this configuration file to manage and program these
elements. If you have more than one system, you can manage multiple systems within one configuration file or
create multiple configuration files. An alternative to manually creating the elements of a configuration file is to use
the Discover tool. For more information on discovering Curtiss-Wright hardware, see “Using Discover” on page 47.
To manually add instruments, first prepare a new configuration file.
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1. Open DAS Studio 3.
A new XidML® 3.0 file named NewConfiguration.xidml is automatically created.

2. On the Quick Access Toolbar or the File menu, click Save As, choose a location and then specify a name for 
the new configuration, such as BasicConfiguration.xidml.

Adding instruments
Instruments such as PCs, chassis and switches are added from the configuration node, BasicConfiguration.xidml.
(The configuration node is referred to as the overview node, because other components such as instruments and
links appear under it.)

NOTE:  You must add all of the physical components of your data acquisition system to your configuration file 
before attempting to connect them. For information on connecting these components, see “Connecting 
instruments” on page 21.

1. To add a PC, click the Click here to begin button in the Navigator.

Instruments Palette opens. For information on Instruments Palette settings, see Table 11 on page 159.

NOTE:  Palettes are context sensitive and are driven by the context they are called from; for example in the 
Navigator, the selected node is the context.
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2. On the PC tab, select a PC and click Add. 
The overview node and the PC are added in the Navigator.

3. Expand the PC node.
Empty slots appear indicating where modules can be added.

4. Right-click on an empty PCM-CIA slot and then click Add Instrument.

Overview node
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Instruments Palette opens.

5. On the Other tab, select a SAM/DEC/007 and click Add. 
The SAM/DEC/007 is added to the PCM-CIA-Slot node. 

6. To add a chassis, do one of the following:

 •  Select the overview node and then click the Add Instrument + button.

 •  Right-click the overview node and then click Add Instrument.

Instruments Palette opens.

7. On the DAU tab, select a chassis and click Add.
The chassis is then added under the overview node.

For information on working with instruments, see “Renaming instruments and links” on page 60, “Removing
instruments” on page 61, “Renaming instruments and links” on page 158, and “Selecting instruments” on
page 161.
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Adding modules to instruments
Instruments such as modules and PCI cards are added to empty slots of a chassis or PC.
1. Expand the chassis node.

Empty slots appear under the chassis indicating where modules can be added.

2. To add a controller module to the chassis, do one of the following: (A controller module can only be added to 
slot 2.)

 •  Right-click empty slot 2 and then click Add Instrument. 

 •  Select empty slot 2 and then click the Add Instrument + button.

 •  Double-click empty slot 2.

Instruments Palette opens. For information on Instruments Palette settings, see Table 11 on page 159.

3. Select a controller module, such as a KAD/BCU/101/D, and click Add. 
The controller is added to slot 2 of the chassis.

4. To add an analog module, right-click an empty slot and then click Add Instrument. (You can also select an 
empty slot and then click the Add Instrument + button, or you can double-click an empty slot.)
Instruments Palette opens.

5. Select an analog module, such as a KAD/ADC/109/C/S1, and click Add. 
The module is added under the chassis node.

NOTE:  When possible, multiple modules can be added by the palette through enabling the Add check box and 
then specifying the number in Copy Rules.

6. Run Serial Number Synchronizer (see “Serial Number Synchronizer” on page 251) and then run Calibration 
Fetcher (see “Using Calibration Fetcher” on page 85).
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Connecting instruments which support PCM-based data acquisition
PCM-based data streams can be acquired by adding a SAM/DEC/007 and a PCM controller module, for example
a KAD/BCU/101. Follow the steps in this section to ensure the programming link necessary is included in your
configuration file.
1. To connect the SAM/DEC/007 to the KAD/BCU/101, first expand the SAM/DEC/007 node to display the 

PCM-in node.

2. Then right-click the PCM-in node and then click Connect. 

The Connect dialog box appears.

For more information on linking, see “Connecting instruments” on page 174. 

3. Select a PCM-OUT channel under MyKAD_BCU_101_D and then click Connect.
The Connect dialog box creates the link between the two instruments. The navigator context determines if the 
source or destination channel is shown in the Packages tab where packages can be added.
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4. To add a PCM stream, click the Import Package button in the Package Properties pane.
For more information on packages, see “Adding packages to an existing link or connected channel” on 
page 23. 

Adding packages to an existing link or connected channel
After links have been added or channels connected, packages can be attached to them. 

NOTE:  Packages can be added to channels without the need for a link to be created. The Packages tab automati-
cally creates the link when required.

1. With the KAD/BCU/101 in context, select the channel in the Channels pane of the Packages tab.

2. Click the Import Package button in the Package Properties pane.
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Packages Palette opens.

3. Select a package, such as MyIRIG-106-Ch4Package2_200x256 (this is a transmission package, and is empty 
by default), and then click Add. 
For information on settings in the Packages Palette dialog box, see Table 14 on page 177.
The package is added to the Package Properties pane. 

For more information on adding packages without first creating links, see “Adding packages from the 
Navigator” on page 60. For information on working with packages, see “Selecting packages” on page 178.
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Adding parameters
After defining a package, you can specify parameters for the PCM package data on the Transmission Assistant tab
of the Packages tab.
1. At the bottom of the Packages tab, click the Transmission Assistant tab.

NOTE:  When working with transmission packages, for example MyIRIG-106-Ch4Package2_200x256, only 
parameters that can be sourced from the chassis are available for placement. If the package is an input 
to a chassis, for example a message on a bus monitor module, then new parameters are added to the 
package to indicate parameters of interest from the package being received. Parameters added in this 
way are then chassis source parameters that can be placed in other transmission packages.

2. Select the parameter to be placed.

3. Select the desired sample rate, for example 64, from the drop-down list. 
Only those rates applicable to the frame definition and parameter type are displayed.

4. Press the Enter key to confirm the sample rate.
A check mark appears in the first column to indicate the parameter is ready for placement.
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5. Click .
The parameter is placed in the first available location in the frame.

For more information on working with parameters, refer to the following sections:
• “Disconnecting parameters” on page 98

• “Adding existing parameters from the This File library” on page 123

• “Adding new parameters from the New ACRA Component library” on page 124

• “Setting multiple parameter placement preferences” on page 128

• “Removing (un-placing) parameters” on page 130

• “Reading package tags” on page 148

• “Using Parameters” on page 183 

• “Changing parameter settings” on page 184.

• “Transmission Assistant” on page 131

PCM example summary
The following figure shows our completed example of a basic configuration with the instruments, channels, links,
packages, and parameters added. In a setup with hardware connected, you would then configure module settings,
run both Serial Number Synchronizer (see “Serial Number Synchronizer” on page 251) and Calibration Fetcher
(“Using Calibration Fetcher” on page 85), and then program the hardware as shown in “Programming
instrumentation” on page 66.

Figure 6: Basic configuration packages tab
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Reading asynchronous PCM data
This section explains how to set up a KAM/DEC/XXX module by importing a 3rd party PCM frame. The following
procedure should be read in conjunction with TEC/NOT/066 - KAD/DEC/103.
1. Create the 3rd party PCM frame consisting of a chassis and a KAD/BCU/101. 

The KAD/BCU/101 settings are: NRZ-L; 200 words; and 1 minor frame at 25600 bps. 
Add fixed data parameters and rename them to represent the parameters you want to read from the 3rd party 
PCM.
Save the file, for example as 3rdPartyPCM.xidml for importing later to your system configuration.

2. Save a new configuration file, for example as RealSystem.xidml.

3. Add a KAD/BCU/140 module.

4. Add a KAD/DEC/103 module and then clear the Synchronous Mode check box for the PCM_In(0) channel.

5. Expand the KAD/DEC/103 node and then expand the Inputs node.

 

6. Right-click the PCM-In(0) channel and then click Add/Import Package.
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7. Click the Import library button, then browse to the 3rdPartyPCM.xidml file and click Open.

 

8. In the Packages Palette table, select the package and click Add With Connections.

9. Now when you select the KAD/DEC/103 PCM-In(0) channel, you see the package and its parameters shown 
in the Package Properties and Content/Placed Data panes below.
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The parameters from the 3rd party PCM frame can now be used in the configuration. 

10. In the Navigator, select the Ouput/Ethernet channel on the KAD/BCU/140 and then click the Packages tab.
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11. Click the Place Parameter button to open the Parameters Palette. 

The asynchronous PCM frame parameters are now in the list of available parameters and can be placed in the 
output Ethernet frame. 

Network to legacy PCM programming
To program a legacy PCM system over Ethernet, the programming channels of the controller and the Ethernet
module must be connected. If they are not connected, programming is attempted over a SAM/DEC/XXX module.
1. Expand the KAD/ETH/101/B node and then expand the Outputs node.

2. Right-click PROG-Out and then click Connect.
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3. In the Connect ‘Prog Out’ dialog, click the KAD/BCU/101/D PROG link and then click Connect.

On mouse over, you see a programming link is now established between the KAD/BCU/101/D and the 
KAD/ETH/101/B.

NOTE:  If the system is a legacy PCM system over Ethernet, all the KAD/BCU/101 PROG-Out must also be con-
nected to the KAD/ETH/101 PROG-Out.

Setting up a KAD/EBM/102 to parse automatically generated packets from the Multi-
Chassis Scheduler (MCS)
For this example, the system is composed of two DAUs (KAM/CHS/03U) and a grandmaster switch
(NET/SWI/101/B/SB2). One DAU contains a KAD/EBM/102 and a KAD/ENC/106. Because the KAD/ENC/106
contains parameters from both DAUs, the KAD/EBM/102 must be set up to filter MCS packets.
First run Discover to detect the hardware in the configuration.
1. Ensure the hardware being detected is connected and has power.

2. On the File menu, click Discover (see “Using Discover” on page 47).
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The detected hardware is shown in the Navigator.

 

3. On the KAD/BCU/140/D module, set the PTP Protocol to PTPv1.
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4. On the NET/SWI/101/B/SB2 switch, set the Time Protocol to PTPv1 on each port.

5. Configure the crossbar so that port 1 is not routed to port 2. And port 2 is not routed to port 1 as shown below.
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6. To connect the links between the switch ports and the chassis, expand the Bi-directional node, right-click 
Switch-Port(1) and then click Connect.

7. Select Ethernet(0) on the KAD/BCU/140/D under the first chassis and then click Connect.

8. Now, right-click Switch-Port(2) and connect to the second KAD/BCU/140/D.

9. Finally, right-click Switch-Port(3) and connect to the link on the KAD/EBM/102.

10. To configure the KAD/EBM/102 to accept MCS packets, set Traffic Type to iNET-X and then set Operating 
Mode to Promiscuous. 

NOTE:  When the KAD/EBM/10x is required to parse MCS and generic packets, the Auto Configure check 
box must be selected.

11. Click the  button to add a single process. 
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12. Change the Destination IP Address setting to 235.0.0.2, for example. 
(The Destination IP address must be unique in the system.)

13. In the iNET-X Parsing pane, select the Source IP Address (iNet-X) and Stream ID (iNet-X) check boxes. 

All parameters from the remote chassis are now available on the KAD/ENC/106 enabling you to build your 
PCM.
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Chapter 4
DISCOVER - DISCOVERS CONNECTED CURTISS-WRIGHT 
HARDWARE

Discover is a Studio plug-in tool used to build a system configuration by detecting existing Curtiss-Wright
hardware. Detected hardware is analyzed and a XidML task file is generated with default hardware settings and
parameters.

Figure 7: Discover overview

Using Discover
Before Discover can detect non-network or network connected hardware, you must indicate the IP address or the
chassis ID for the connected hardware. Detecting instruments which support Simple Network Management
Protocol (SNMP) does not require IP addresses or chassis IDs. The number of devices found and a summary of
discovered devices and modules is displayed at the end of discovery.
This chapter includes the following tasks:
• “Discovering network instruments” on page 47

• “Discovering non-network instruments” on page 51

• “Discovering a mixed configuration of network and non-network instruments” on page 53

Discovering network instruments
You can use the Discover tool to locate instruments across a network, such as recorders and switches.

For devices that support SNMP
For devices that support SNMP, such as AXN/BCU/XXX, KAD/BCU/140, SSR/CHS/XXX, NET/REC/XXX, and
NET/SWI/XXX, refer to the following.
1. Ensure your PC is on the same subnet as the hardware being detected and that your firewall is disabled for 

that subnet. 

2. Ensure that the hardware is connected and has power.

XidML 3.0
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3. On the File menu, click Discover.

4. In the Hardware Discovery dialog box, click Run Discovery to start discovery.

Discover detects connected hardware and generates a file with default hardware settings.

NOTE:  During discovery of an Axon system, the last XidML file that was programmed is retrieved from the 
AXN/BCU/xxx.

 

5. Do one of the following:

 •  Click Save File to save the configuration file.
You are prompted to enter a name and location to save the file to.

 •  Click Save and Load.
You are prompted to enter a name and location to save the file to; you are also prompted to save any 
unsaved changes in the active configuration. Thereafter, the configuration file loads in DAS Studio 3.

NOTE:  You cannot use the same file name as the active configuration.
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For devices that do not support SNMP
For devices that do not support SNMP, such as KAD/BCU/105, an IP address range must be specified. Refer to
the following.
1. Ensure your PC is on the same subnet as the hardware being detected and that your firewall is disabled for 

that subnet. 

2. Ensure that the hardware is connected and has power.

3. On the File menu, click Discover.

4. In the Hardware Discovery dialog box, click Expected Gateways and then do one of the following:

 •  Select the Ethernet / RS-485 check box for KAD/ENC/004/B, KAD/BCU/101, KAD/BCU/105, KAD/BCU/140 
or KAD/BCU/140/X1 controllers that do not support automatic discovery.

 •  Select the TFTP check box for KAD/BCU/140/B or later controllers that do not support automatic discovery.

5. Select IP Address, then right-click and select Add.

6. In the From and To fields of the Add Ethernet Gateway dialog box, type the IP address range for the network 
instruments that are connected and then click Add. 
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The list of network instrument IP addresses to search for is shown below the IP Address node.

7. Click Run Discovery to start discovery.
Discover detects connected hardware and generates a file with default hardware settings.

8. Do one of the following:

 •  Click Save File to save the configuration file.
You are prompted to enter a name and location to save the file to.

 •  Click Save and Load.
You are prompted to enter a name and location to save the file to; you are also prompted to save any 
unsaved changes in the active configuration. Thereafter, the configuration file loads in DAS Studio 3.

NOTE:  You cannot use the same file name as the active configuration.
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Discovering non-network instruments
You can use the Discover tool to locate non-network instruments such as chassis.

NOTE:  SNMP discovery is automatically run so all network devices are always discovered.

1. Ensure the hardware being detected is connected and has power.

2. On the File menu, click Discover.

3. In the Hardware Discovery dialog box, click Expected Gateways and then select the Ethernet / RS-485 
check box.

4. Select Chassis ID, then right-click and select Add.

5. In the From and To fields of the Add PCM Gateway dialog box, type the range for the chassis that are 
connected and then click Add. 
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The list of chassis IDs to search for is shown below the Chassis ID node.

 

6. Click Run Discovery to start discovery.
Discover detects connected hardware and generates a file with default hardware settings.

 

7. Do one of the following:

 •  Click Save File to save the configuration file.
You are prompted to enter a name and location to save the file to.

 •  Click Save and Load.
You are prompted to enter a name and location to save the file to; you are also prompted to save any 
unsaved changes in the active configuration. Thereafter, the configuration file loads in DAS Studio 3.

NOTE:  You cannot use the same file name as the active configuration.
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Discovering a mixed configuration of network and non-network instruments
You can use the Discover tool to locate instruments within a mixed configuration of network and non-network
instruments.

NOTE:  In a mixed configuration, for non-network instruments to be discoverable, the configuration must include an 
Ethernet module, for example a KAD/ETH/101 or a KAD/ETH/102.

1. Ensure the hardware being detected is connected and has power.

2. On the File menu, click Discover.

3. In the Hardware Discovery dialog box, click Expected Gateways and then select the Ethernet / RS-485 
check box.

4. Select IP Address, then right-click and select Add.

5. In the From and To fields of the Add Ethernet Gateway dialog box, type the IP address for the network 
instrument that is connected and then click Add. 



54    DAS Studio 3 User Manual (SW/BK/0015 | 13 Sep. 2021)

4

  

The network instrument IP address to search for is shown below the IP Address node.

6. If there are no non-network chassis connected, click Run Discovery and go to step 10.

7. To discover non-network chassis that are connected to the network instrument, right-click the IP address and 
then click Add.

 

8. In the From and To fields of the Add PCM Gateway dialog box, type the chassis ID range for the chassis that 
are connected to the network instrument and then click Add.
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9. The Hardware Discovery dialog box is now populated with all the IP addresses and chassis IDs that you want 
to discover.

 

10. Click Run Discovery to start discovery.
Discover detects connected hardware and generates a file with default hardware settings.

11. Do one of the following:

 •  Click Save File to save the configuration file.
You are prompted to enter a name and location to save the file to.

 •  Click Save and Load.
You are prompted to enter a name and location to save the file to; you are also prompted to save any 
unsaved changes in the active configuration. Thereafter, the configuration file loads in DAS Studio 3.

NOTE:  You cannot use the same file name as the active configuration.
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Chapter 5
NAVIGATOR - PROVIDES AN OVERVIEW OF THE SYSTEM 
CONFIGURATION

The Navigator provides an overview of how the system is configured. It displays the system's instrument hierarchy
in a tree view. It shows instruments, channels and connected links.

Figure 8: Navigator overview

The overview node is the top-most node on the tree and shows the name of the configuration file currently being
edited. 

Overview node

Child nodes
(click to expand 
or collapse)
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Using the Navigator
The Editor tabs display data for the currently selected node in the Navigator and its child nodes. 
Taking the Settings tab as an example, if you select the overview node from the Navigator, settings for all the
instruments in the Navigator are displayed in the Settings tab (see the following figure).

Figure 9: Settings for overview node

If you now select an instrument in the Navigator, only the settings for that instrument are displayed (see the
following figure).

Figure 10: Settings with instrument selected

Navigator Editor tabs
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This chapter includes the following tasks:
• “Adding instruments and links” on page 59

• “Renaming instruments and links” on page 60

• “Adding packages from the Navigator” on page 60

• “Removing instruments” on page 61

• “Removing links and disconnecting channels” on page 62

• “Collapsing the Navigator” on page 63

Adding instruments and links
Instruments and links are added using a node's context menu (for more information, see “Adding instruments” on
page 19 and “Connecting instruments” on page 21).

Add With Connections option
The palettes—instruments, links, packages, parameters, and algorithms—all have an Add With Connections
button. This option is typically used when you have already configured a system and you want to reuse parts in a
new configuration. 

Figure 11: Add With Connections - Instrument Palette

For example, if you add a chassis to your configuration only the chassis itself is added. If you use the Add With
Connections option, the chassis and all instruments, links, and packages that were attached to the chassis are also
added. 

NOTE:  The Add With Connections option currently only supports automatically adding attached parameters for 
source packages.
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Renaming instruments and links 
Links and instruments can be renamed in the Navigator. 
1. To rename an item, double-click or right-click on the item and then click Rename.

2. Rename as required and then press the Enter key.

If you choose a name that already exists, a warning dialog box appears.

Adding packages from the Navigator
You can add a package to a channel by right-clicking on the channel in the Navigator. If the channel does not
already have a link attached, then a link is automatically added when you add the package, as described in this
section. For information on adding a package and simultaneously defining the link it is attached to, see “Adding
packages to an existing link or connected channel” on page 23.
1. Right-click the channel where you want to add the package and then click Add Package.

Packages Palette opens. For information on settings in the Packages Palette dialog box, see “Adding 
packages using the palette” on page 178.
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2. Select a package and click Add.

The package is added and a link is automatically added.

Removing instruments
• To remove an instrument, right-click on the instrument in the Navigator and click Remove Instrument.
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Removing links and disconnecting channels
When you remove a link that has packages and parameters connected at only one end, the link and any attached
packages and parameters are deleted from the configuration file.
Whereas removing a link that has packages and parameters connected at both ends, only removes the link
reference from the instrument’s channel. Likewise, disconnecting a link only removes the link reference from the
instrument’s channel. Disconnect a link when you want to connect it to a different instrument. See “Connecting
instruments” on page 174.
• To remove a link: Right-click on the channel in the Navigator, click Advanced and then click Remove Link.

• To disconnect a channel: Click the Disconnect Channel button in the Packages tab.
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Collapsing the Navigator
To allow a better view when working in the Editor, the Navigator can be collapsed. 
• To expand or collapse the Navigator, click the expand button. 

Expand button
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Chapter 6
PROGRAM - VERIFIES AND PROGRAMS CONFIGURATION 
DATA

The Program tool has two operating modes: Verify and Program; these are available in the Tools menu of DAS
Studio 3.
Verify does not communicate with hardware. It verifies that the data throughput and sequencing specified in the
configuration can be achieved.
Program verifies that the data throughput and sequencing specified in the configuration can be achieved and then
programs the instrumentation.

Figure 12: Program overview

Using Verify and Program
When you have defined your system configuration, use Verify to verify that the desired data throughput and
sequencing requirements can be realized on the instrumentation, then use Program to program the
instrumentation when it is connected. 
Before you verify or program a configuration, review the DAS Studio 3 default programming options (see “Using
the DAS Studio 3 Options dialog box” on page 5). The Options dialog has a Compile Parallel setting, which
enables parallel compilation. This is only recommended for large multi-chassis systems. Each chassis is
processed in parallel to reduce verifying and programming times. The recommended PC requirements for parallel
compilation are a quad core processor and 8 GB of RAM.
Refer to the following to verify and program using parallel compilation. 

XidML 3.0
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1. On the File menu, click Options.

2. Select the Compile Parallel check box.

3. Click Close to exit the options dialog box.

NOTE:  The same Compile Parallel option is also available on the DAS Studio Standalone Compiler. See the 
Standalone Compiler data sheet for details.

This chapter includes the following tasks:
• “Verifying instrumentation” on page 66

• “Programming instrumentation” on page 66

• “Errors when verifying or programming instrumentation” on page 67

Verifying instrumentation
Verify does not communicate with the hardware, therefore hardware does not need to be connected.
1. On the Quick Access Toolbar or the Tools menu, click Verify.

The tool verifies that the desired data throughput and sequencing requirements can be realized on the 
available instrumentation. A message box is displayed reporting if verification passed or failed.

 

2. Do one of the following:

 •  If the verification step succeeds, click OK; the instrumentation is ready to be programmed. 

 •  If the verification step fails, refer to “Errors when verifying or programming instrumentation” on page 67.

Programming instrumentation 
1. Ensure the hardware you are programming is connected and powered on.
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2. On the Tools menu, click Program.

Serial Number Synchronizer and Calibration Fetcher are run first. This synchronizes the configuration to the 
connected hardware, updates the configurations serial numbers and then reads the calibration information. This 
calibration information is used by the compiler to configure each analog for optimal accuracy.
The tool then verifies that the desired data throughput and sequencing requirements can be realized on the 
available instrumentation and programs the connected hardware. If verification fails, programming is not 
performed and error messages are shown. A message box is displayed reporting if programming passed or 
failed. 

3. Do one of the following:

 •  If programming succeeds, click OK.

 •  If programming fails, refer to “Errors when verifying or programming instrumentation” on page 67.

Errors when verifying or programming instrumentation
When errors are detected, a red error icon flashes over the Message Server icon in the notification area (see the
following figure). Double-click the icon to open the Message Server dialog box and locate the error(s) shown in red
text. Use the error message as a guide to correct the configuration file and then re-run the tool. 

Figure 13: Opening Message Server from notification area

Additionally during programming, detected errors are consolidated from the Message Server and missing devices
are listed in the following Error dialog. 

Double-click to open 
Message Server
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Figure 14: Errors detected during programming instrumentation
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Chapter 7
IP ADDRESS PROGRAMMER - UPDATES THE IP ADDRESS 
OF CURTISS-WRIGHT NETWORK DEVICES

The IP Address Programmer interfaces directly with the hardware that you want to program the IP address of. No
configuration file is needed at the programming stage, as the change only occurs in the hardware. 

Figure 15: IP Address Programmer overview

Using IP Address Programmer

NOTE:  If the PC you are using to program has two active Ethernet ports, then DAS Studio 3 reports an error, even 
though the IP address of the module is set correctly. To prevent this error, ensure one of the Ethernet ports 
is disabled. 

The following protocols are used to update the IP address:
• “SNMP protocol” on page 70

• “KAD/BCU/105 controllers protocol” on page 71

• “Ethernet transmitters protocol” on page 72

• “Axon Family Chassis protocol” on page 73

• “Information and error messages when running IP Address Programmer” on page 74
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SNMP protocol
The SNMP protocol is used for recorders, switches, and KAD/BCU/140 controller families. The IP address is
updated through SNMP commands. The present IP address and the new IP address are required to update the
module. 
Refer to the following to update the IP address:
1. On the Tools menu, click IP Address Programmer.

The IP Address Programmer dialog box opens with the SNMP protocol displayed.

2. Type the IP address in the Present IP Address field.
To confirm that the present IP address exists on the network and is the expected device, click Read Device.

The device is read and its part reference and serial number are shown.

3. Type the new IP address in the New IP Address field.
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4. To set the new IP address, click Program.
If power cycling is required after programming to update the IP address, the following dialog is displayed 
allowing the ping test to be canceled.

5. Power cycle the module and then click Yes. 
If you cannot power cycle the module, click No to cancel the post programming ping test. 

If the post programming ping test is successful, the following screen appears.

KAD/BCU/105 controllers protocol
The KAD/BCU/105 controllers IP address update protocol uses 239.0.0.0 broadcast packet along with two pins
connected on the connector. The IP address is updated by connecting pin 7 (IP_ASSIGN) to pin 4 (BVDD) and
sending a UDP broadcast packet on 239.0.0.0. The existing IP address is not needed to update the IP address.
Refer to the following to update the IP address:
1. On the Tools menu, click IP Address Programmer.

The IP Address Programmer dialog box opens.

2. In the Protocol drop-down list, select BCU/105 controllers.

3. Type the new IP address in the New IP Address field and then click Program.
The following dialog box opens.
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4. Connect pin 7 (IP_ASSIGN) to pin 4 (BVDD) on the controller’s connector (this places the module into IP 
Assign mode and prevents it responding to its present IP address) and then click Yes. 

5. Disconnect pin 7 from pin 4 on the controller’s connector and then click OK.

If the post programming ping test is successful, the following screen appears.

Ethernet transmitters protocol
The Ethernet KAD/ETH/101 and KAD/ETH/102 transmitters IP address update protocol uses 224.0.0.3 broadcast
packets along with two pins connected on the connector. The IP address is updated by connecting pin 39
(IP_ASSIGN) to pin 51 (GND) and sending a UDP broadcast packet on 224.0.0.3. The existing IP address is not
needed to update the IP address.
Refer to the following to update the IP address:
1. On the Tools menu, click IP Address Programmer.

The IP Address Programmer dialog box opens.

2. In the Protocol drop-down list, select Ethernet transmitters.

3. Type the new IP address in the New IP Address field and then click Program.
The following dialog box opens.
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4. Connect pin 39 (IP_ASSIGN) to pin 51 (GND) on the controller’s connector (this places the module into IP 
Assign mode and prevents it responding to its present IP address) and then click Yes. 

5. Disconnect pin 39 from pin 51 on the controller’s connector and then click OK.

If the post programming ping test is successful, the following screen appears.

Axon Family Chassis protocol
The Axon Family Chassis protocol is used for AXN/BCU/xxx controller families. The IP address is updated through
http. The present IP address and the new IP address are required to update the module. 
Refer to the following to update the IP address:
1. On the Tools menu, click IP Address Programmer.

The IP Address Programmer dialog box opens.

2. In the Protocol drop-down list, select Axon Family Chassis.

3. Type the IP address in the Present IP Address field.

4. Type the new IP address in the New IP Address field and then click Program.
The following dialog box opens.
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Information and error messages when running IP Address Programmer
You may see an information or error message as shown in the following table while running IP Address
Programmer.

Table 1: IP Address Programmer messages

Message Description/solution

When power cycling is required after programming to 
update the IP address, this dialog allows the ping test to 
be canceled.

The IP address you assigned has been updated.

IP address programming is canceled as the new IP 
address you requested already exists.

IP address programming is canceled as the present IP 
address does not exist on the network. 

For further details, refer to the Message Server.
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Chapter 8
RECORDER STATUS - DISPLAYS THE STATUS OF 
CONNECTED HARDWARE

The Recorder Status tool displays the status of connected hardware in a status window. For example, the following
figure shows the Recorder Device Status dialog box when a recorder is connected.

Figure 16: Device Status overview

Using Recorder Status with recorders
• On the Tools menu, click Recorder Status. 

The Device Status dialog box opens.

Fill Level displays the fill level as a percentage of the media storage capacity.
Logging displays the recording state. Green indicates recording is taking place; red indicates not recording.

If the Device Status indicates Not Logging, move the START/STOP switch on the recorder to the START 
position to record.
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Chapter 9
IP CONFLICT DETECTOR - CHECKS FOR IP CONFLICTS ON 
NETWORK

The IP Conflict Detector tool is used to check that there are no conflicting IP addresses on your network (see the
following figure). You provide the range of IP addresses to check, and the tool sends traffic to each node within the
range. Conflicting IP addresses are listed and can then be easily resolved.

Figure 17: IP Conflict Detector overview

Using IP Conflict Detector
To run IP Conflict Detector, WinpCap must be installed. WinpCap can be downloaded here:
https://www.winpcap.org/install/default.htm 
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1. On the Tools menu, click IP Conflict Detector. 

The IP Conflict Detector dialog box opens.

2. In the Network Device drop-down list, select the network adapter you want to check for conflicts on.
(If only one adapter is listed, it is automatically selected.)

3. The Generate Traffic From/To IP fields are populated according to the IP address of the selected network 
adapter. 
Change these fields up to a maximum range of 256 addresses. 

4. In the Stop After field, type the number of traffic packets to be sent before broadcasting stops.

5. Click Start to start searching for conflicts.

Any conflicting IP addresses are displayed in the Detected Conflicts table. The MAC addresses of the 
conflicting devices are in the adjacent columns.

NOTE:  After you click the Start button its label changes to Re-Start. 
The Start/Re-Start button generates new traffic and clears the results from the Traffic table. Whereas, 
the Generate ARP Traffic button generates traffic but adds it to the existing results in the Traffic table.
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6. Use the MAC address to locate one of the conflicting devices and then change its IP address so that it is 
unique on the network. 
It’s only necessary to change the IP address of one of the conflicting devices.

7. Click Clear to remove the results from the Detected Conflicts table and then click Re-Start to check again 
that all conflicts are resolved.

Table 2: IP Conflict Detector settings

Setting Description

Traffic

Count Number of the packet sent

Link Type of link such as Ethernet.

Type Traffic type such as ARP, IpV6, or IpV4.

Source IP Addr. Source IP address traffic was sent from.

Destination IP Addr. Destination IP address traffic was sent to.

Destination MAC Addr. Destination MAC address traffic was sent to.

Length Length of traffic packet.

Detected Conflicts

IP Address Conflicting IP address.

MAC Address #1 MAC address of first unit with conflicting IP address.

MAC Address #2 MAC address of second unit with conflicting IP address.
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Chapter 10
BRIDGE BALANCER 3 - AUTOMATED BALANCING/NULLING 
TOOL

Bridge Balancer 3 is used to automatically balance or null up to thousands of bridge outputs acquired using a
distributed Acra KAM-500 architecture (see the following figure). Balancing the signal before it reaches the
instrumentation amplifier allows the maximum gain to be used in the signal conditioning channel. Acra KAM-500
modules such as the KAD/ADC/109, KAD/ADC/114, and KAD/ADC/118 support this feature (see “Supported
analog modules” on page 84.

Figure 18: Bridge Balancer 3 overview

Using Bridge Balancer 3
Before running Bridge Balancer 3 you need to retrieve calibration information if applicable (see “Using Calibration
Fetcher” on page 85) and program a valid configuration file. When Bridge Balancer 3 starts, it determines the
location of DAS Studio 3 installation files and the relevant location of the system programming files (cache). 
If you have changed the default location of DAS Studio 3 and its associated programming files, then you need to
enter the new location in the Balance Configuration dialog box as described in “Changing the default location and
choosing a network card” on page 81.

NOTE:  Bridge Balancer 3 does not support PCM.

Changing the default location and choosing a network card
Only run Configure Bridge Balancer if you have changed the default location of DAS Studio 3 or if your system has
more than one network card. 
1. On the Tools menu, click Bridge Balancer. 

The Bridge Balancer dialog box opens.

DAS Studio 3 Bridge Balancer 3
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2. Click Setup then Configure Bridge Balancer.

The Balance Configuration dialog box opens.

3. If you have changed the default location for installation files, click the browse button next to the Cache Folder 
Location field and browse to the new location.

4. If your system contains more than one network card, select the network card you want from the Choose 
Network Card pane. 

5. Click Close.
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Balancing parameters 
1. On the Tools menu, click Bridge Balancer. 

The Bridge Balancer dialog box opens.

'

2. In the Balance Tolerance column, type the maximum plus and minus allowed deviation from the target value.
The percentage is of full scale deflection and the allowed values are 0.01 to 99.99.

NOTE:  Use the Shift and Ctrl keys to select multiple parameters. Use Ctrl + A keys to select all parameters in 
a column and then type the value you want in any row; all rows assume the value you typed.

3. In the Balance Target column, type the balance value to be achieved.
This value depends on the input range of the parameter.

4. In the Bridge Resistance column drop-down list, select the nominal resistance of the strain gage.

5. Select the Balance Now check boxes for all parameters that you want to balance.

6. Click Start to balance the selected parameters.

When you click Balance, Bridge Balancer 3 calculates a correction value for each parameter selected, sets it in
XidML and then applies it to the appropriate analog module. The appropriate voltage level is then automatically
programmed into the corresponding onboard D/A converter (connected via a resistor Radj) to the input of the
instrumentation amplifier along with the sensor. The new reading for the channel is reported in the Value column as
a voltage.
For example, a parameter with an input range of ±100mV, a target voltage of 0 and a desired tolerance of 0.1%,
the balance current adjusts until the value read for that parameter is greater than -0.2mV and less than 0.2mV.
Once this has been achieved, the parameter is said to be balanced as it is within the required accuracy. 
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If a channel fails to balance, a warning is generated in the Message Server window and the parameter line is
highlighted in the GUI.
After balancing is finished, the XidML task file is updated with the balance current settings calculated for each
channel and the bridge resistance used for each channel. 

NOTE:  The original XidML task file is backed up before balancing begins in a \Tools\BridgeBalancer\BackUp direc-
tory.

When the selected channels have been balanced, you can use Quicklook to read and analyze acquired data.

NOTE:  Bridge Balancer 3 supports Unicast and Multicast IP addressing modes.

Parameter status 
The following table describes colors which indicate parameter state in Bridge Balancer 3:

NOTE:  The PC hosting Bridge Balancer 3 must be connected to the Acra KAM-500 system's programming and 
data interfaces in order to be able to set the required balance values and check that they have been 
achieved. The Value column displays the actual values read from the hardware for the corresponding 
parameters.

Supported analog modules
Bridge Balancer 3 supports the following modules:

Color Parameter state

No color Parameter has not been selected for balancing or its balance state is unknown.

Red Bridge Balancer 3 has determined that the parameter cannot be balanced to the required target 
and tolerance value.

Green Bridge Balancer 3 has balanced this parameter or has determined that the parameter is already 
balanced.

AXN/ADC/401 KAD/ADC/109/C/S1 KAD/ADC/118/100m KAD/ADC/118/10V

KAD/ADC/118/1V KAD/ADC/114/10V KAD/ADC/135 KAD/ADC/136
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Chapter 11
CALIBRATION FETCHER - RETRIEVES CALIBRATION 
DATA FROM HARDWARE

The Calibration Fetcher tool retrieves calibration details from any attached modules which support calibration. The
tool accesses each connected module and retrieves its calibration information. It then creates a local copy of this
calibration information on the host PC. The calibration information is used during any subsequent verification and
programming process performed within DAS Studio 3. It is run automatically during programming but can be
disabled through the Options dialog (see “Program and Verify” on page 6).

Figure 19: Calibration Fetcher overview

Using Calibration Fetcher
To ensure Calibration Fetcher can access all connected modules, run the Discover tool before you run Calibration
Fetcher. See “Using Discover” on page 47.

WARNING: To ensure internal calibration from all modules is taken into account during programming, Calibration
Fetcher must be run every time a new instrument is added to the system and the instrument’s serial
number must be in the task file. If not, the module may be outside of the accuracy specified in the mod-
ule data sheet. 

1. Ensure connected hardware has power.

2. Open the task file for the hardware that is to be analyzed by the Calibration Fetcher tool.
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3. On the Tools menu, click Calibration Fetcher. 

The Calibration Fetcher dialog box opens.

4. Click Fetch Calibration Data. 
Calibration data is retrieved and saved automatically. 

NOTE:  Text in the above Status pane will be blue to indicate a warning and red for an error.
5. Click Close to exit Calibration Fetcher.

The saved calibration data is used the next time the Program tool is run. See “Programming instrumentation” on
page 66.
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Errors when running Calibration Fetcher
You may see an error message as shown in the following table after running Calibration Fetcher. 

Table 3: Calibration Fetcher error messages

Error message Description

Failed to fetch calibration data If you have followed all the steps in “Using Calibration Fetcher” on 
page 85, this error may indicate that there are no attached modules 
that support calibration, and therefore there is no calibration data to 
be retrieved. 

Please Run Verify/Compilation Pro-
cess before running Calibration 
Fetcher

Indicates that instrumentation has not been verified. See “Verifying 
instrumentation” on page 66. 

Cannot Run Calibration Fetcher, No 
Task file Loaded

Calibration Fetcher was started before the relevant task file was 
opened.

Failed to fetch calibration data, task 
canceled by user

The Close button was clicked before Calibration Fetcher had finished 
retrieving data.
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Chapter 12
PACKAGE GENERATOR - PACKAGE GENERATION WIZARD

The Package Generator tool is used to create a set of transmission packages (for example, from a PCM or
Ethernet transmitter) from a user-selected set of parameter rates. The tool shows all parameters that are available
for transmission where you can select which are to be sent and define the rate. The Package Generator then
creates a selection of packages to group all these parameters in an optimum arrangement.

Figure 20: Package Generator overview

Navigator Editor
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Using Package Generator
Before using Package Generator at least one link must be attached to an output channel.

NOTE:  We recommend that you do not use Package Generator to build PCM systems, instead use Transmission 
Assistant (located at the bottom of the Packages tab). See “Transmission Assistant” on page 131.

1. On the Tools menu, click Package Generator. 

NOTE:  You can also right-click on a link in the DAS Studio 3 Navigator to open Package Generator. When 
opened this way, the Package Generator Navigator is not shown.

2. In the Package Generator dialog box Navigator, select the link that you want to add packages to. 
The Editor shows all available parameters that can be added. (Package Generator is context sensitive; the 
node you select in the Navigator determines the content in the Editor.)

3. In the Editor, select the parameters that you want to add. 

NOTE:  Parameters can be sourced from multiple chassis. The software automatically handles the transport of 
parameters that are sourced from modules not located on the same chassis as the transmitter. 
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4. In the Sample Rate drop-down menu, select the sample rate.

5. If required, change settings for the other fields described in Table 4 on page 91.

NOTE:  Most of these settings are not available for Ethernet packages. 

6. Click Generate Packages to add the package.

Table 4: Package Generator settings

Setting Description

Base Sampling Frequency Frequency of the packet (Hz).

Bit-Rate Output bit-rate of PCM transmitter.

Minor Frames / Frame Number of PCM minor frames in a major frame.

Sync Word Synchronization word for PCM minor frames.

Bits / Minor Frame Number of bits in a PCM minor frame.

Fix PCM Shape and Rate Select this check box to manually fix the PCM shape and rate.
If this check box is clear, the generator creates an optimum frame shape for the 
data transmission selected.

Bandwidth Optimization Move the slider to the left if you want one sample per parameter in a single 
sample-rate package; move the slider to the right for each package to be as full 
as possible while maintaining coherency.

INET-X / IENA Output-package type.
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Chapter 13
SETTINGS TAB - INSTRUMENT SETTINGS EDITOR AND 
VIEWER

The Settings tab is used to determine the behavior and function of hardware. When a hardware component is
selected in the Navigator, its settings and associated registers are displayed on the Settings tab and can be
modified as required. 

Figure 21: Settings tab overview
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Using the Settings tab
The information displayed in the Settings tab depends on the node selected in the Navigator. When the overview
node in the Navigator is selected, settings for all the nodes in the Navigator are displayed in the Settings tab. 
If another node (such as the module shown in the following figure) is selected in the Navigator, only the settings
and associated registers for that module are displayed in the Settings tab.

Figure 22: Settings tab when single module selected

TIP!    Move the mouse pointer over cells in the Settings tab to see tooltip descriptions from the instrument’s 
XdefML file. XdefML provides a mechanism for FTI vendors to capture their hardware's configuration possi-
bilities in an XML file. For more information on XdefML, go to http://www.xidml.org.

This chapter includes the following tasks:
• “Modifying settings” on page 95

• “Selecting and modifying multiple fields” on page 95

• “Locating invalid settings” on page 97

• “Viewing the Range Maximum, Range Minimum, Gain, and Offset columns” on page 98

• “Disconnecting parameters” on page 98

• “Adding parameters with default names” on page 99

• “Changing the source of a parameter” on page 99

• “Generic module settings” on page 99

• “Port routing setup for switch modules” on page 103

• “Configuring a KAD/ADC/136 module” on page 116

http://www.xidml.org
http://www.xidml.org
http://www.xidml.org
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Modifying settings

NOTE:  Only properties/cells with a white background can be modified; properties/cells with a yellow background 
are read-only and cannot be modified.

Use the Settings tab to modify settings such as Clock Phase and PCM Code.
1. Make the required changes.

Settings are validated using the rules defined in the XdefML files.

2. On the File menu, click Save to save the changes to the configuration file.

Selecting and modifying multiple fields 
You can use the keyboard, mouse, or right-click context menu shortcuts to modify multiple fields in a column at the
same time.

Using the Shift and Ctrl keys
1. In the Range Maximum column, click in the first row and while holding the Shift key, click in the last row that 

you want to select. 
(You can make this same selection by clicking in the first row and while holding the mouse button drag across 
the other rows you want to select. Alternatively, you can use the Ctrl key to select non-adjacent rows.)

2. Click in the first row to put the field in edit mode and then change to a new value such as 5.
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3. Press the Enter key. 
All values are changed to 5.

Using the right-click Update all column values function
1. In the Range Minimum column, click in the first row to put the field in edit mode and then change to a new 

value such as -5.

2. Click outside the field to exit edit mode and then right-click in the field and click Update all column values to 
‘-5’.

All values are changed to -5.
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Updating combo box fields
Settings that use combo boxes such as Filter Cutoff can also be changed with these methods.
1. When selecting multiple rows of combo boxes, be sure to click on the blue borders of the cell as shown here. 

Then while holding the Ctrl key and the mouse button, drag across the rows you want to select.

2. Change the setting you want and press the Enter key to apply it to all selected fields.

Locating invalid settings
If settings are outside allowable values (as predefined by the XdefML file), the cell containing the invalid value is
highlighted by a red box and a red error icon appears on the tab. The setting must be changed to an allowable
value before continuing with the system configuration. 

Figure 23: Errors highlighted in Settings tab

Error icon Error location

Move mouse over 
error or over status 
bar to see mesage 
details
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NOTE:  For a description of settings and acceptable values for a particular module, refer to the respective data 
sheet. To locate data sheets, see “Opening instrument data sheets” on page 158.

Viewing the Range Maximum, Range Minimum, Gain, and Offset columns
The Settings tab displays parameters from the active node in the Navigator. For modules listed in the following
table, Gain and Offset values can be displayed instead of Range Maximum and Range Minimum. This can be
changed through the Settings tab context menu. If the configuration does not have one of these modules then
these display options are disabled.
• To change the column display, click the Settings tab arrow, click Options and then choose the setting you 

want.

Disconnecting parameters
Default parameters are already attached to each instrument.
1. To disconnect a parameter, click the drop-down arrow.

2. Select Disconnect from the drop-down menu.
The parameter is disconnected.

Table 5: Gain/Offset supported module families

KAD/ADC/011 KAD/ADC/012 KAD/ADC/014 KAD/ADC/019 KAD/ADC/105

KAD/ADC/106 KAD/ADC/109 KAD/ADC/111 KAD/ADC/112 KAD/ADC/114

KAD/ADC/116 KAD/ADC/117 KAD/ADC/118 KAD/ADC/120 KAD/ADC/126

KAD/ADC/129 KAD/ADC/135 KAD/CDC/001 KAD/CDC/101 KAD/LDC/101

Click here Choose a setting
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For information on removing parameters completely, see “Removing (un-placing) parameters” on page 130.

Adding parameters with default names
When adding a parameter, or sub-parameter, on the Settings tab, DAS Studio 3 provides a default parameter
name.
To add a parameter when there is no default parameter, do the following.
1. In a Parameter Name field, click the drop-down arrow.

2. Do one of the following:

 •  Select Add new parameter.
A new default parameter for the respective field is inserted.

 •  To add an existing parameter, select Add parameter from palette and then add the parameter you want 
from Parameters Palette. For more information on the Parameters Palette settings, see Table 15 on 
page 179.

Changing the source of a parameter
You can change the source of a parameter. For example, to move the source of a parameter to another instrument
without modifying the package content, do the following:
1. In the drop-down list for the parameter, click Replace.

2. Select the This File library from the palette.

3. Select a parameter.

Generic module settings
This section gives a description of the settings available for different module types that are supported in DAS
Studio 3.

Packetizer module settings
The following figure shows the Settings tab with a packetizer module in context (KAD/ABM/102). To enable
packetization on a particular channel of a packetizer module (such as a KAD/MBM/101 or KAD/ABM/102), select
the Packetization Enabled check box. If more than one channel is enabled, ensure each has a unique Stream ID.
Upon verification, DAS Studio 3 automatically creates the respective parser-aligned packet. For information on
running Verify, see “Verifying instrumentation” on page 66.
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Figure 24: Settings for a packetizer module

NOTE:  Packet size refers to the number of backplane transfers and not the actual size of the packet. For more 
information on the structure of packetizer packets, see TEC/NOT/067 - IENA and iNET-X packet payload 
formats.

Packetization Sink
This setting is on each packetizer source and allows multiple or single destinations to be set. In the following
configuration there are two packetizer destinations: a KAD/BCU/140/D and a KAM/MEM/113.

Figure 25: KAD/BCU/140/D and a KAM/MEM/113 packetizer destinations

The following figure shows channel 0 being only transmitted on the KAD/BCU/140/D by selecting Controller Only.
Channel 1 is only stored in the KAM/MEM/113 by selecting Slot 5. Channel 2 is stored and transmitted by selecting
All.
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Figure 26: Packetizer sink options for multiple destinations

Packetizer Format
This controls the header of the packetizer package. Selecting IENA iNET-X Hybrid generates an IENA header and
an iNET-X payload data in the packetizer package as shown in the following figure.

Figure 27: IENA iNET-X Hybrid packetizer package

NOTE:  Mixed header types are not allowed in a configuration.

Analog module settings
The following figure shows the Settings tab with a KAD/ADC/109/C/S1 in context. In this screen you can adjust
typical setting such as Range, Gain, and Filter Cutoff. The Gain and Offset columns are not shown by default; you
must enable them as described in “Viewing the Range Maximum, Range Minimum, Gain, and Offset columns” on
page 98. For tooltips on a setting, move the mouse pointer over the setting. 

Figure 28: KAD/ADC/109 module settings

Mouse over tooltip for settings
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Discrete module settings
The following figure shows the Settings tab with a KAD/DSI/002 module in context. In this screen you can adjust
typical setting such as Counter Type, Range Maximum, Trigger Edge, Data Format, threshold levels, and arming
events. For tooltips on a setting, move the mouse pointer over the setting.
The parameter’s Range Maximum value is controlled by the channel’s Counter Type setting.
Discrete event arming controls which discrete inputs are logged in the event tagging FIFO.

Figure 29: Example settings for KAD/DSI/002 module

Module global 
registers

Counter Type settings

Threshold level settings

Discrete event arming
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Port routing setup for switch modules
DAS Studio 3 uses a Custom Display on the Settings tab to configure complex port routing for switches. This
section describes the overall functionality of the Custom Display using a NET/SWI/003 switch as an example.
Other examples use a KAD/SWI/108 to demonstrate specific funtionality.
The NET/SWI/003 is configured with a static forwarding table whereby Ethernet frames received on an input port
can be forwarded to any output port on the switch. To simplify configuring this routing table, a crossbar tool is
provided as shown in the following figure. To see tooltips on a setting, move the mouse pointer over the setting.

Figure 30: Custom Display with NET/SWI/003 in context

Switch-level settings
The fields at the top of the Custom Display are instrument-wide settings. Under the settings is the crossbar grid
that may have a zoom control. This zoom control allows the crossbar grid to magnify if required.

Mouse over tooltip for settings
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Figure 31: Instrument-wide settings

Port routing
Connections between input and output ports are represented by a grid with the input and output ports on each axis.
To make a connection between ports, click the appropriate crossbar. The following figure shows a connection
between port 3 and port 2. Port 3 is now output to port 2.

Figure 32: Connection between two ports

When multiple connections are configured, it can be difficult to see connections for a specific port as shown in the
following figure.

Figure 33: Connections between multiple ports 
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Input-to-outputs port routing (input port specified)
To clearly see the ports that a particular port is output on, click its input toggle button. The grid then only highlights
the output routing for that port. The following figure highlights the output routing for input port 3. This is the same
configuration as displayed in the previous figure.
Click the toggle button again to turn off selective routing and to show routing for all ports.

Figure 34: Connections between multiple ports with input port of interest visible 

Inputs-to-output port routing (output port specified)
Similarly, to see what input ports are routed to a particular output port, click its output toggle button. The grid only
highlights the input routing for the selected output port. Click the toggle button again to show routing for all ports.

Figure 35: Connections between multiple ports with output port of interest visible 
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Connection speed
The Speed setting lets you configure the speed of each port. As shown in the following figure, the default setting is
Auto (auto negotiate).In this mode, line speeds from both sides of the transmission are sensed, and the highest
compatible speed is chosen.

Figure 36: Connection speed options

Switch routing example
The example configuration shown in the following figure has eight chassis (KAM/CHS/13U) and three switches;
one standalone switch (NET/SWI/005/B) and two DAU switch modules (KAD/SWI/108), one in each of the chassis
3 and 6.

Figure 37: Example configuration with DAU switch in context
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As shown in the following figure, the two KAD/SWI/108s are routed such that port 4 is routed to ports 1, 2, and 3.
While ports 1, 2, and 3 are routed to port 4. This routing has configured port 4 as the aggregator port and the
communication port to the other ports. 

Figure 38: KAD/SWI/108 routing
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As shown in the following figure, the NET/SWI/005/B is routed such that ports 1, 2, 3, and 4 are routed to ports 15
and 16. Third party Ethernet traffic is also routed through this switch on Input Ports 9, 10, and 11: port 9 talks to
ports 12 and 16; port 10 talks to ports 13 and 16; and port 11 talks to ports 14 and 16. Port 16 is connected to a PC
and can access all input, whereas port 15 can only access half of the system (through ports 1, 2, 3, and 4).

Figure 39: NET/SWI/005/B routing

Filtering on NET/SWI/003
Filtering is applied after port routing. If an output port has no input port routing, then filtering has no impact on it.
As shown in the following figure, the Broadcast and Unicast settings allow you to filter out broadcast or unicast
packets from being transmitted on an output port.
A broadcast is a transmission to every node reachable on the network or subnet. A unicast is a separate
transmission stream from source to destination for each recipient.

Figure 40: Broadcast and unicast filtering
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Multicast Filter Strategy allows you to apply multicast MAC address filtering to each output port. Multicast MAC
addresses are those in the range 01-00-5E-00-00-00 to 01-00-5E-FF-FF-FF. 
As shown in the following figure, there are four types or strategies:
• Allow - allows all multicast MAC addresses to pass 

• Block - blocks all multicast MAC addresses

• Pass Filter and Reject Filter - allow selective filtering of multicast MAC addresses

To allow a particular multicast MAC address to pass on an output port, select Pass Filter for that port and add a
MAC Address entry using the Add button. The default value is the next available address. Specify the desired
multicast MAC address. This multicast MAC address is only allowed through to the output port. Up to 31 multicast
MAC addresses can be specified. The opposite filtering strategy can be implemented by selecting Reject Filter. In
this case, only packets with multicast MAC addresses that match an entry in the table are rejected; all other MAC
addresses are allowed through.

Figure 41: Multicast filtering strategies

The MAC Address field allows you to add filter table entries. Type the number of filters in the Add field and click
Add. The filters are added as shown in the following figure. Check boxes indicate the ports where multicast filtering
strategies are assigned.

Figure 42: Adding filter table entries

To delete a row, select the row by clicking to the left or right of the MAC address field and then click Remove. (Use
the Ctrl of Shift keys to select multiple rows.)

Figure 43: Deleting filter table entries
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Filtering on KAD/SWI/108, NET/SWI/101/B and NET/SWI/101/C
The following three filtering options are available:
• None - Filtering is not applied.

• Output Port - Filtering is applied to all input ports of a port.

• Cross Point - Filtering is applied to each cross point.

The following procedures use a KAD/SWI/108. The same procedures can be followed for a NET/SWI/101/B and
NET/SWI/101/C with one difference; Filtering Mode in the KAD/SWI/108 is called Filtering in the NET/SWI/101/B
and NET/SWI/101/C. 

Output Port filtering
1. In the Filtering Mode drop-down list, select Output Port.

2. Click OK in the Filtering Mode dialog.
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A filter button appears under each output port.

3. Click the filter button for the port you want to configure.
The Output Port Filtering dialog box appears.
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4. Select Block in the Strategy drop-down list and then click Add to add a new filtering rule.

5. In the All Filtering Rules pane, in the first classifier column after Instruments, select Destination IP Address 0 
from the drop-down list and then type the first part of the destination IP address.

6. In the next column, select Destination IP Address 1 from the drop-down list and then type the rest of the 
destination IP address.

7. Select the output port that the filtering will apply to.
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8. In the Available Module Rules pane, select the rule and then click Add.

The rule is moved to the Output Port Rules pane and the output port counter indicates that 1 blocking rule is 
applied. This rule prevents packets with destination IP address 235.0.0.2 from being forwarded from ports 2, 3, 
and 4 to port 1.

NOTE:  If Strategy is set to Allow and no rules are defined for an output 
port, no packets are allowed through and the cross points appear 
red as shown here.
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Cross Point filtering
Refer to the following to set a rule on the cross point of two ports.
1. In the Filtering Mode drop-down list, select Cross Point and then click OK in the confirmation dialog box.

2. Click the cross point that you want to configure.
The Cross Point Filtering dialog box appears.

3. Select Block in the Strategy drop-down list and then click Add to add a new filtering rule.
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4. In the first classifier column after Instruments, select Destination IP Address 0 from the drop-down list and then 
type the first part of the destination IP address.

5. In the next column, select Destination IP Address 1 from the drop-down list and then type the rest of the 
destination IP address.

6. In the Available Module Rules pane, select the rule and then click Add.

The rule is moved to the Cross Point Rules pane and the output port counter indicates that 1 blocking rule is 
applied. This rule prevents packets with destination IP address 235.0.0.2 from being forwarded from port 3 to 
port 4.

NOTE:  If Strategy is set to Allow and no rules are defined for a cross point, then no packets are allowed 
through. The cross point is not active as shown in the following figure.
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Configuring a KAD/ADC/136 module
Starting with DAS Studio 3.4.14, a number of changes have been made to the UI for KAD/ADC/136 modules to
simplify their configuration. A single table is used to configure the module. The table only displays the settings
required for the channel input types. However you can still display all settings and setup each channel as required.
When a module is added from the palette the default input mode for all channels is Differential ended voltage. This
is displayed as D-E in the Input Mode column and only range, excitation and filter settings are then visible as
shown in the following figure. 

Figure 44: Module showing default input mode for all channels

Short Input Mode names
Input Mode names have been abbreviated to increase the number of columns that can be displayed on screen at
any time.

Table 6: Input Mode abbreviated names

Long name Short name

Differential ended voltage D-E

Single ended voltage S-E

Thermocouple T

Half-bridge H-B

Full-bridge F-B

RTD sensor RTD

ICP sensor ICP
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Column setting visibility
To simplify channel setup only settings commonly used by the Input Mode types in context are displayed.

NOTE:  To override the channel type column visibility preferences and show all settings, select the All check box in 
Display Options.

The following figures show settings when Differential ended, Thermocouple, and ICP Input Mode is selected.

Figure 45: Differential ended voltage column

Figure 46: Thermocouple column display

Figure 47: ICP sensor column display

When all Input Mode types are used on a module, all columns are visible but only those used by the channel are
editable in the channel rows as shown in the following figure.

Figure 48: Module showing all Input Mode types in use
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Thermocouple
The follow columns are displayed: Channel, SubChannel, Parameter, Parameter Vendor Name, Range Maximum,
Range Minimum, Parameter Units, Input Mode, Filter Mode, Filter Cutoff, Linearization Algorithm Reference,
Junction Compensation Channel and Classic Shunt
The following columns are hidden: Excitation Mode, Excitation Amplitude, Half-bridge Completion Resistors,
Junction Compensation Channel, Balance.Type, Balance.Applied, Balance.BalanceThisTime, Balance.Tolerance,
Balance.Achieved, Balance.Target, Balance.Actual and ShuntCurrent.Applied.

Display Options
These check boxes allow you to display and modify settings that are normally hidden by the active channel types.

Sensors selection
The temperature sensors for thermocouple and RTD channels are now displayed in a drop-down list and are
controlled by the channel type.

Navigator channel context
Selecting a channel in the Navigator reduces the columns to the relevant settings for its type.
The Thermocouple channel type is displayed as T with no excitation or balance settings displayed as shown in the
following figure.

Table 7: Display Options

Display Options Description

All Allows all channel settings to be displayed allowing full module configuration. If the module has setting 
groups these will be displayed immediately after the All check box.

Balance/Shunt The KAD/ADC/136/C has two setting groupings: Shunt and Balance. To see all shunt settings, select 
the Shunt check box, regardless of the channel type.

Table 8: Temperature sensors

Temperature 
Channels

Description

RTD sensor
All sensor files in the ‘LookupFiles/RTD’ subdirectory are in the drop-down list.
The file extension is removed. The file PT100_385.LU is displayed as PT100_385 in the drop-down 
list.

Thermocouple
All sensor files in the ‘LookupFiles/Thermocouple’ subdirectory are in the drop-down list. The file 
names are truncated by removing the extension and a ‘TYPE’ prefix if present.
The file TYPEK.LU is displayed as K in the drop-down list.



CHAPTER 13: SETTINGS TAB - INSTRUMENT SETTINGS EDITOR AND VIEWER     119

  

Figure 49: Thermocouple channel selected in navigator

When a Full-Bridge channel type is selected all settings are displayed as shown in the following figure.

Figure 50: Full-bridge channel selected

Errors
If a row contains an error a warning is displayed and a red box indicates the field that needs correction. Move the
mouse pointer over the field to see a tooltip on how to correct the issue.

Figure 51: Tooltip error example

Parameter ranges
As shown in the following figure, Range maximum and minimum cannot be the same.

Figure 52: Minimum maximum error example

Thermocouple configuration errors
When a change is configured as a Thermocouple, its Junction Compensation Channel must reference an RTD
channel. When it does not, the thermocouple channel and the referenced channel are highlighted as shown in the
following figure.

Figure 53: Thermocouple configuration error example

Mouse over tooltipError warning
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Table cell restrictions
Table cells are restricted by the channel type/input mode to make module configuration easier.

Figure 54: Table cell restrictions

When the channel type is RTD, the Excitation Mode must be Current.
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Chapter 14
PACKAGES TAB - PACKAGE EDITOR AND VIEWER

The Packages tab contains Channels, Package Properties and Content panes as shown in the following figure.

Figure 55: Packages tab

The packages displayed in the Package Properties pane depend on the selected channel in the Channels pane.
The package displayed in the Content pane is dependent on the package selected in the Package Properties
pane. Panes can be collapsed or expanded by double-clicking on the title bar of the pane as indicated in the
previous figure.

Using the Packages tab
The information displayed in the Packages tab depends on the node selected in the Navigator. When the overview
node in the Navigator is selected, channels (which support package definitions) for all the instruments in the
Navigator are displayed in the Channels table of the Packages tab. If another node is selected in the Navigator,
only the channels for that node are displayed in the Packages tab.

NOTE:  Only properties/cells with a white background can be modified; properties/cells with a yellow background 
are read-only and cannot be modified.

Channels

Package 
Properties

Content

Double-click on title bar to collapse/expand pane

Placed Data/Transmission Assistant (PCM only) tabs
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The Channels table 
Any channels that support package definitions, based on the current Navigator context, are listed in this table (see
“Connecting instruments” on page 174). Properties associated with the channel are displayed (for example,
Channel Name and Bit Rate). 

Figure 56: Channels table

The Package Properties table
If the channel that is selected in the Channels table contains packages, they are listed in this table. You can add
packages using Package Generator (see “Using Package Generator” on page 90) or the Import Package function
(see “Adding packages using the palette” on page 178). If the channel contains packages of different types, the
packages are grouped into tabs based on their type.

Figure 57: Package Properties table

 Package Generator
Import Package
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The Content pane
The Content pane is controlled by the active package in the Package Properties table. It consists of an overview
grid of the selected package and a table of placed data. Each parameter has a default color to aid parameter
placement and overview. 

Figure 58: Content pane

This chapter includes the following tasks:
• “Adding existing parameters from the This File library” on page 123

• “Adding new parameters from the New ACRA Component library” on page 124

• “Setting multiple parameter placement preferences” on page 128

• “Removing (un-placing) parameters” on page 130

• “Removing packages” on page 130

• “Transmission Assistant” on page 131

• “Smart Placement mode” on page 132

• “Placing single parameters” on page 132

• “Moving a parameter within a frame” on page 134

• “Adding multiple parameters” on page 135

• “Removing (un-placing) parameters from a PCM frame” on page 136

• “Creating a PCM discrete parameter” on page 140

• “Generating a PCM package report” on page 143

• “Advanced parameter settings” on page 144

Adding existing parameters from the This File library
You can access parameter libraries, or existing parameters, using the Import Parameter button. The This File
library lists all available parameters in the configuration file. Any of these parameters can be placed in packages by
adding a reference to them.

Overview 
grid

Content 
table

Package 
Properties 
table

Drag to 
resize
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NOTE:  To add multiple parameters from the Parameters Palette, hold the Ctrl key while selecting the parameters 
you want or hold the Shift key and select a continuous group of parameters.

1. To add a parameter, click the Place Parameter button.
(When adding the first parameter to a package, you must use the Place Parameter button; right-click options 
are not available. Thereafter, you can use right-click options as shown below to add frames.)

Parameters Palette opens.

2. In the This File library, select the parameter you want and click Add Reference.

Adding new parameters from the New ACRA Component library
The New ACRA Component category provides a library of predefined components, which can be used to build a
system. The New ACRA Component library is used when you want to add parameters to packages on a bus
monitor module such as a KAD/IBM/101. The library is only available when adding parameters to bus monitor
modules and is otherwise not shown in the palette library.
When adding parameters to packages, it is possible to filter the list of predefined parameters to find a parameter
with the desired characteristics (such as size in bits) and add it to the package with a custom name.

Right-click option to 
add parameters

Right-click on empty 
cell to place 
parameters
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NOTE:  To add multiple parameters from the Parameters Palette, hold the Ctrl key while selecting the parameters 
you want or hold the Shift key and select a continuous group of parameters.

1. Click the Place Parameter button.
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Parameters Palette opens.

2. In the New ACRA Component library, select a parameter, rename it if required, and then click Add. 
(To enable and use filtering, see “Filtering and sorting parameters” on page 180.)
The parameter is assigned a default color and added to the package.

Adding a fixed parameter
Fixed parameters are used as bookmarks to help users identify specific parts of the frame. They are typically used
to set an identification number for the configuration such as the aircraft tail number. 

To place a fixed value at the next available location in the package
1. In the Placed Data pane, click the Place Fixed Parameter button.

Click for 
filtering 
options 
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2. Type a value and click Add.

The fixed parameter is placed in the next available cell.

To place a fixed parameter at a specific location in the package
1. Right-click in the cell where you want to place the fixed parameter and select Add Fixed Parameter.

2. Type a value and click Add.

The fixed parameter is placed in the next available cell.
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Setting multiple parameter placement preferences
Use the global preferences option to define how multiple parameters are placed in packages. The settings you
choose apply to new parameters and new configurations until you change the preferences again. 
1. For Placement Orientation, choose Place Parameters Horizontally (default) or Place Parameters Vertically. 

(Vertical placement can only be used with PCM packages.)

2. For Placement Strategy, choose Contiguously (default) or Non-Contiguously. (Non-contiguous placement 
can only be used with PCM packages.)

 •  Contiguous placement ensures the parameters are placed next to each other in the package. If a parameter 
already exists in the package that would cause an overlap, then placement is not allowed. In the PCM 
package example shown below, the parameter at offset 6 would cause an overlap if you tried to place five or 
more parameters contiguously from offset 2.

 •  Non contiguous placement also places parameters next to each other in the package but if another 
parameter is already placed that would cause an overlap, the remaining parameters are placed after this 
parameter. In the example shown above, when placing five or more parameters from offset 2, the parameter 
at offset 6 would be skipped.

Placement Strategy

Placement Orientation

Offset 6
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3. Click the Default Occurrences button or right-click a parameter in the packages Content table and then click 
Preferences.

Depending on the packet in context—Ethernet or PCM—one of the following Placement Preferences dialog 
boxes appears.

 •  Ethernet packets: Type a value for Default Occurrences and click Save.

 •  PCM packets: Select Standard Placement or Burst Placement.
Burst Placement allows you to place consecutive samples (irregular placement) of the same parameter in 
a PCM frame, as opposed to evenly spaced samples (standard placement). This consecutive placement is 
referred to as a burst. 
In the Burst Size field, specify the size of the burst.
In the Repeat Burst field, specify the number of times the burst repeats across the frame. Each repeat of a 
burst is placed regularly across the frame. 

Below is an example of a video parameter burst. The burst size is 4 and the repeat is 10.

Click to set occurrences
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NOTE:  Not all parameters support burst placement. Therefore, if Burst Placement is set, only parameters that 
support burst placement (such as video and snarfer parameters) are shown in the Parameter Palette.

Removing (un-placing) parameters
When you want to remove a parameter from the payload of a package, you un-place the parameter. This removes
the reference to the parameter from the package; it does not delete the parameter from the configuration file.

NOTE:  You can un-place multiple parameters from the Content table by holding down the Ctrl key and selecting 
parameters; you can only un-place one parameter at a time from the overview grid.

• To un-place a parameter, right-click on the overview grid’s cell that contains the parameter or right-click the row 
that lists the parameter and click Un-place parameter or Un-Place Data. 

For details of how to disconnect a parameter, rather than removing it, see “Disconnecting parameters” on page 98.

Removing packages
1. In the Package Properties table, select the package you want to remove.

The selected package row text changes to blue.

2. Right-click the package row and then click Remove package.

Right-click to un-place 
parameter
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Transmission Assistant
The Transmission Assistant tab is designed to replace the Package Generator functionality for PCM frame
generation and has a similar User Interface.
Refer to the following to set up a basic configuration that uses PCM transmission:
1. Add a KAM/CHS/13U, KAD/BCU/101/E, and a KAD/ADC/109/C to the configuration.

NOTE:  At this point, the Transmission Assistant tab is not shown because no PCM packages are in context.

2. Click the Import Package button then select a package in the Packages Palette and then click Add.

The package is added to the Package Properties pane and the Placed Data and Transmission Assistant 
tabs are added to the bottom of the Packages tab.

Click the arrow 
to open in a new 
window
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To open Transmission Assistant in its own window, click the arrow in the top-right corner of the tab. 

The Transmission Assistant tab lists all placeable parameters and the Sample Rate column indicates whether 
each parameter is placed or non-placed.

Smart Placement mode
With Smart Placement mode, DAS Studio 3 automatically places parameters in the optimum location within the
frame. Disable Smart Placement when you want to place the parameter at any available location in the frame, or to
allow DAS Studio 3 to place the parameter in the first available cell.
To toggle Smart Placement mode, click the Smart Placement icon or press the F6 key.

Placing single parameters

You can place parameters by using the  icon in the Transmission Assistant tab or by dragging the parameter to
the Content pane. You can also use keyboard shortcuts as shown in the tooltips when you move the cursor over a
button.

NOTE:  When moving parameters to a specific location as shown below, Smart Placement mode must be disabled. 
If Smart Placement mode is enabled, DAS Studio 3 may place the parameter in a different location than the 
one you choose.

1. Select the parameter to be placed.

 

2. Select the desired sample rate, for example 2, from the drop-down list. 
Only those rates applicable to the frame definition and parameter type (analog, digital or video) are displayed. 
In this case the frame shape only allows multipliers of 2 and 5.

Click (or press F6) to enable/disable 
Smart Placement mode 

Enabled

Disabled
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3. Press the Enter key to confirm the sample rate.
A check mark appears in the Can Place column to indicate the parameter is ready for placement.

4. Do one of the following:

 •  Click  (or press Alt + Enter).
The parameter is placed in the first available location in the frame.

 •  Drag the parameter to the desired empty cell in the Content pane.

5. Now click the Smart Placement icon (or press the F6 key) to enable Smart Placement.
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6. Prepare another parameter for placement.

7. Click   (or press Alt + Enter) to place the parameter.

Due to Smart Placement, the parameter is added at the optimum location in the PCM frame, which in this case 
is sub frame 30.

Moving a parameter within a frame
You can move a parameter from one location in a frame to another. 
• To move a parameter, drag it to the desired empty cell in the Content pane.

Smart Placement enabled
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Adding multiple parameters
The procedure for adding multiple parameters to a PCM frame is similar to that for adding one parameter. Refer to
the following:
1. Ensure Smart Placement is disabled.

2. Select the parameters you want to add. (Use the Ctrl key to select non-contiguous parameters.)

3. Press the F2 key to initiate edit mode on all selected rows. The Sample Rate drop-down menu appears.

4. Select a sample rate and press the Enter key.
The same sample rate is applied to all selected parameters; check marks in the Can Place column indicate the 
parameters are ready for placement.

5. Do one of the following:

 •  Click  (or press Alt + Enter).
The parameters are placed in the first available location in the frame and the Can Place check boxes are 
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cleared. Note, the color each parameter is assigned is matched in the Is Placed column.

 •  Drag the parameters to the desired empty cell in the Content pane.

Removing (un-placing) parameters from a PCM frame
When you want to remove a parameter from a package, you un-place the parameter. This removes the reference
to the parameter from the package; it does not delete the parameter from the configuration file.
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1. Select the parameters that you want to un-place (use the Ctrl key to select non-adjacent parameters). 

2. Click  (or press Ctrl + D) to un-place the parameters.
The parameters are removed from the frame and Can Place check boxes are selected.

 

NOTE:  You can also un-place a parameter by right-clicking it in the overview grid and then selecting Un-place 
parameter. However, with this method you can only un-place one parameter at a time.

Locking/unlocking parameters
Parameters already placed in the PCM frame may be locked in position to prevent them from being moved to a
different location when additional parameters are placed. This functionality is useful if parameters must be placed

Overview 
grid
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at specific locations. Parameters can be manually placed and then locked in position. Additionally, Transmission
Assistant prevents locked parameters from being un-placed (removed).

Figure 59: Locking a parameter in position

Persistent Settings
Parameter setting such as Sample Rate, Commutation, Tx Start Bit, Tx Stop Bit, and Fragmentation are not saved
to the XidML file unless first placed in the PCM frame. To allow you to edit and persist the value of these settings
without having placed the parameter in the PCM frame, Transmission Assistant automatically detects and records
changes to these settings to maintain persistence. For persistence purposes, each row in the table is uniquely
identified by the unique combination of XidML File Name, PCM Packet Name and Parameter Name. 
The following features are available for viewing and updating the storage of parameter settings.

Export to CSV file

1. Click  to export the information in persistent storage for the currently selected package to a CSV file.

2. Choose the location to save the file.
A CSV file with the following naming convention <XidML File Name>_<PCM Packet Name> is created. 
For example a XidML file called “MyTask” containing the PCM packet “MyPCMPacket” results in a CSV file 
named MyTask_MyPCMPacket.csv.
Below is a typical example of the CSV file contents.

Import data from a CSV file
You can edit the values in a previously exported CSV file and import it back into the database.

Click to export
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1. Click  to import a CSV file.

2. Browse to the file you want and then click Open.

Archiving of all persistent data
The archive feature allows you to export the data stored for all PCM packets to a CSV file. 
The storage of parameter settings does not persist between subsequent installations of DAS Studio 3. When
upgrading or reinstalling DAS Studio 3 and you want to retain content then you can use this feature to retrieve pre-
existing data.

NOTE:  Persistent storage of parameter settings not placed in the PCM frame is not maintained between subse-
quent installations of DAS Studio 3. If upgrading or reinstalling DAS Studio 3—and persistence of parame-
ter settings is required—then it is necessary to archive all pre-existing data as described here. 

1. Click  to export data to a CSV file.

2. Browse to the location you want to archive the data.

Click to import

Click to export
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Deleting of all persistent data

1. Click  to delete all persistent data.

2. Click Yes to confirm.

Creating a PCM discrete parameter
The PCM Discrete Parameter Builder is used to save bandwidth. It does this by building a new parameter from
specific bits from several parameters. Refer to the following to create a PCM discrete parameter.
1. On the Transmission Assistant tab, click the Create New PCM Discrete Parameter button.

2. The PCM Discrete Parameter Builder dialog opens.
(See the following table for descriptions of the fields in this dialog.)

3. Click Create.
A default name (MyPCMDiscrete) and size (16 bits) is assigned for the new parameter.

Click to export
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Fields appear in the Construction pane, which allow you to choose the parameters to extract bits from.

4. Click the first Select source parameter button.
The PCM Discrete Particle Selection dialog opens.

Use the Only show # bit parameters check box to filter which parameters are displayed. (It is enabled by 
default.)
Use the search field to locate parameters you want. 

5. Click Next/Previous to browse multiple matches.

6. For this parameter we will take the first four bits and place them at the start of the new parameter.
by applying the following settings:

 •  Extraction Offset = 0 (source parameter start bit)

 •  Extraction Bits = 3 (number of consecutive bits to take from the source parameter)

 •  Placement Offset = 0 (start bit in new PCM discrete parameter)
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7. Click Select to choose the parameter you want.
The parameter is shown in the PCM Discrete Parameter Builder dialog.

8. Place the next parameter in the same way. 
Select source parameter rows automatically appear for any empty bits.
Map at the bottom of the screen shows the layout of the new PCM discrete parameter.
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Generating a PCM package report
You can generate a CSV or html report for the selected PCM package. The report contains the PCM properties,
frame layout, and a list of placement parameters.
1. Click the Generate PCM package report button.

2. Choose the format for the report, .csv or .html and then click Save.
By default, reports use the same name as the package and are saved to the DAS Studio 3 installation folder.

Table 9: PCM Discrete Parameter Builder

Setting Description

Shows any PCM discrete parameters you have created; empty on first use

Click to delete the parameter that is currently shown

Click to create a new PCM discrete parameter

Name Field to rename the default name

Description Field for optional description of PCM discrete parameter

Bits Size of the PCM discrete parameter

Construction

Name Name of source parameter

Description Field for optional description of source parameter

Extraction Offset Source parameter start bit

Extraction Bits Number of consecutive bits to take from source parameter

Placement Offset Start bit in new PCM discrete parameter

Map Layout of new PCM discrete parameter
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3. Open the report in a browser (.html) or excel spreadsheet (.csv) as required.

 

Advanced parameter settings

Controlling which bits of a parameter are transmitted
You can use the Tx Start Bit and Tx Stop Bit fields to control the number of bits of a parameter that are transmitted
in the frame. As shown in the following figure, only the first five bits of the ReadCounter parameter will be
transmitted.

Figure 60: Modifying Tx Start/Stop Bits

Bits to be 
transmitted

Stop field 
modified
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Control how parameters are split across transmission words
Fragmentation allows you to split parameters across word boundaries. The size in bits of each split fragment is
specified as a comma or colon-delimited list. (A colon separated list is always displayed after placement.) The
following figure shows a parameter that has been split across two word boundaries in 8-bit fragments.

Figure 61: Split parameter

Split 
parameter

Colon delimited 
value
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Chapter 15
PROCESSES TAB - PROCESS REGISTER EDITOR AND VIEWER

The Processes tab shows all instrument and channel process registers described in an instrument’s XdefML file
that are not configurable in their builder applications (see "Chapter 25" on page 189). Parameters can be attached
and removed from these registers. Package tag parameters can also be added and removed through the parser
tables in this tab.

Figure 62: Processes tab overview
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Using the Processes tab
The information displayed in the Processes tab depends on the node selected in the Navigator. When the overview
node in the Navigator is selected, process registers for all the nodes in the Navigator are displayed. If another node
is selected in the Navigator, only the process registers for that node are displayed.
Once a new parameter has been attached to a process register it is available in the Parameters pane as shown in
the following figure.

Figure 63: Registers shown in Parameters pane

This chapter includes the following tasks:
• “Reading package tags” on page 148

Reading package tags
Use the Processes tab to read package tags. Package tags are associated information such as microsecond time
of sync bit transition, message count, response time and package errors. To read a package tag, you must first
create a new parser process.
1. (When an instrument does not have a bus monitor builder application and there are no parsers defined on a 

channel or instrument, a general add parser button is displayed. In bus monitor builder applications, parsers 
are configured in parameter's Tag Parameters tab (see “Builder application GUI overview” on page 190.) 
To create a new parser process, click Add parser to instrument MyKADFBM_101_B.

The parser process is added and a new row is inserted into the table.
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2. Now you can add parameters to the tags you are interested in, for example, to add a message count 
parameter, open the drop-down list in the MessageCount column.

3. Now do one of the following:

 •  Select Add new parameter. 
The default parameter for the respective field is added.

 •  Select Add new parameter from palette and then add the parameter you want from Parameters Palette.

 •  Select Add all missing parser parameters. 
This option adds a new default parameter to all the parser registers that do not have a parameter attached.

NOTE:  Sub-parameters are not created; only parent parameters are. For example, the MessageIrigTime48 
parameter is created, but its three 16-bit sub-parameters are not.

 

NOTE:  If an instrument has a catchall parser, any package that is not assigned to a parser, or if its payload is not 
being read, is sent to this catchall parser. As a result, you cannot add packages to the Catch All Parsers 
table.
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Chapter 16
ALGORITHMS TAB - ALGORITHMS SETTINGS EDITOR AND 
VIEWER

The Algorithms tab allows you to view and edit algorithms defined for the module in context in the Navigator pane.
There are two types of algorithms supported in DAS Studio 3: Bit Mask Alarm and Window Alarm. These
algorithms are used by the KAD/BIT/101 and KAM/BIT/102 modules.

Figure 64: Algorithms tab overview

Using the Algorithms tab
If your configuration includes a KAM/BIT/102 module, the Algorithms tab shows all Event trigger algorithms. If
there are no events defined then the Algorithms tab is empty. 
This chapter includes the following tasks:
• “Creating a new Event and algorithm” on page 151

• “Deleting an Event” on page 154

• “Algorithms Palette” on page 154

Creating a new Event and algorithm
Two types of algorithm are supported DAS Studio 3: Bit Mask Alarm and Window Alarm. Bit Mask Alarm algorithms
are triggered by a mask pattern and are generally used by digital parameters. Window Alarm algorithms are
triggered when a value is within a range and are generally used by analog parameters.
The Priority field determines which events are transmitted first if multiple events occur at the same time. Events
with higher priority values are transmitted before ones with lower values. 
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Creating a Bit Mask Alarm Event process
The following steps describe how to create an event Ethernet packet on a KAM/BIT/102 when Switch-Port(1) on a
KAD/SWI/108 is not connected.
1. Select the KAM/BIT/102 in the Navigator and then click the Settings tab.

2. At the bottom of the Settings tab, click the  icon to create a new Event.

A row for the new Event is added.

3. In the Trigger Condition field, click the drop-down arrow and then click Add.

The Algorithms Palette opens. 

4. Select the Boolean-Simple tab. (See “Algorithms Palette” on page 154.)

5. Rename the algorithm or accept the default and then click Add. 
The Parameters Palette opens.

6. Click This File, then select SWI_108_Report and click Add Reference.

7. In the Event Message field, type the text for the event packet, such as port 2 not connected.

8. In the Priority field, assign a priority to the message.
Priority determines which events are transmitted first if multiple events occur at the same time.

9. Click the Algorithms tab to view the Event.

10. In the Trigger Mask field, type **** **** **** ***1. 
This mask ignores all other bits except bit 0 and triggers when bit 0 is 1. Bit 0 of the KAD/SWI/108 report word 
describes the connection state of Port 1; when there is no connection it is 1.
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Creating a Window Alarm Event process
The following steps describe how to create an event Ethernet packet on a KAM/BIT/102 when a KAD/ADC/109
parameter exceeds a specified voltage.
1. Select the KAM/BIT/102 in the Navigator and then click the Settings tab.

2. At the bottom of the Settings tab, click the  icon to create a new Event.

A row for the new Event is added.

3. In the Trigger Condition field, click the drop-down arrow and then click Add.

The Algorithms Palette opens. 

4. Select the Window-Function-Alarm tab. (See “Algorithms Palette” on page 154.)

5. Rename the algorithm or accept the default and then click Add. 
The Parameters Palette opens.

6. Click This File, then select AnalogIn(0) and click Add Reference.

7. In the Event Message field, type the text for the event packet, such as Analog(0) too high.

8. In the Priority field, assign a priority to the message.
Priority determines which events are transmitted first if multiple events occur at the same time.
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9. Click the Algorithms tab to view the Event.

10. Type 7 in the Minimum Value field and type 10 in the Maximum Value field. 
An event packet is generated when this parameter is between 7 and 10 volts.

Deleting an Event
1. To delete an Event, click the Settings tab.

2. Select any cell in the Event row you want to delete. 
(Use the Shift and Ctrl keys to select multiple rows; the number of Events is indicated in the removal field.) 

3. Click next to the delete field to remove the Event.

The Event is deleted.

Algorithms Palette
As shown in the following figure, the Algorithms Palette dialog box contains a library pane from where the source
library or configuration file is selected. The algorithm tables show compatible algorithms from the specified source.
The palette commands are used to add the selected algorithm, while the Renaming Rules pane is used to specify
the naming strategies or to resolve naming conflicts. All palette features are described in Table 10 on page 155. 
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Figure 65: Algorithms Palette overview

Table 10: Algorithms Palette features

Feature Description

New ACRA 
Component

Displays compatible algorithms. In this library, algorithm properties are read only; properties 
can be modified after they are added on the Settings tab.

This File Displays compatible algorithms from the active configuration.

Import Displays compatible algorithms from an external configuration file. 

Algorithm 
table

This table supports column filtering; see “Filtering and sorting parameters” on page 180.

Renaming 
Rules pane

Rename the algorithm or accept the default; see “Resolving naming conflicts” on page 160.

Add The algorithm is added.

Add With 
Connections

Adds the selected component along with any relevant sub components, see “Add With Con-
nections option” on page 59.

Algorithm table

Renaming Rules

Palette 
commands

Libraries
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Chapter 17
DOCUMENTATION TAB - DOCUMENTATION EDITOR AND 
VIEWER

The Documentation tab displays information such as instrument names, part references, serial numbers, and short
and long descriptions in several tables. Instrument channel names and attached links are also displayed in their
own table. All instrument and link names, serial numbers, and short and long descriptions can be edited in this tab.

Figure 66: Documentation tab overview
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Using the Documentation tab
The information displayed in the Documentation tab depends on the node selected in the Navigator. When the
overview node in the Navigator is selected, information for all the nodes in the Navigator are displayed in the
Documentation tab. If another node (such as shown in the following figure) is selected in the Navigator, only the
information for that node is displayed in the Documentation tab.

Figure 67: Documentation tab when single module selected

This chapter includes the following tasks:
• “Renaming instruments and links” on page 158

• “Opening instrument data sheets” on page 158

Renaming instruments and links
1. Double-click the instrument or link name that you want to change and rename it accordingly.

NOTE:  Only properties/cells with a white background can be modified; properties/cells with a yellow back-
ground are read-only and can not be modified.

2. Click File then Save to save the changes to the configuration file.

Opening instrument data sheets
1. To open an instrument data sheet, select the instrument in the Instruments table.

2. Select the Instrument's name cell. 

NOTE:  The instrument data sheet button is active if a data sheet for the instrument is available.
3. Click the Instrument Data Sheet button. 

The instrument data sheet opens in PDF format.
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Chapter 18
INSTRUMENTS PALETTE - ADDING INSTRUMENTS, RESOLVING 
CONFLICTS, AND SELECTING INSTRUMENTS

As shown in the following figure, the Instruments Palette dialog box contains a library pane from where the source
library or configuration file is selected. The instrument tables show compatible instruments from the specified
source. The palette commands are used to add the selected instruments, while the Renaming Rules pane is used
to specify the number instances and the naming strategies or to resolve naming conflicts. All palette features are
described in the following table.

Figure 68: Instruments Palette overview

Table 11: Instruments Palette features

Feature Description

New ACRA 
Component

Displays a library of compatible instruments. In this library, instrument properties are read only; 
properties can be modified after they are added under the Settings tab.

Import Displays compatible instruments from an external configuration file.

Add library Allows you to add a custom library; see “Customizing the library pane” on page 161.

Instruments 
table

This table supports column filtering; see “Filtering and sorting parameters” on page 180.

Renaming 
Rules pane

Rename the instrument or accept the default; see “Resolving naming conflicts” on page 160.

Copying rules Allows multiple contiguous instances of a component to be added. This field is unavailable 
when its use could cause a configuration error.

Instruments table

Renaming Rules

Palette 
commands

Libraries

Copying Rules

Add library
(visible on 
mouse over)
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Using Instruments Palette
Instruments Palette is accessed from the Navigator.
This chapter includes the following tasks:
• “Adding instruments using the palette” on page 160

• “Resolving naming conflicts” on page 160

• “Selecting instruments” on page 161

• “Customizing the library pane” on page 161

• “Customizing the user interface” on page 169

• “Using the XDefML Instrument Import tool” on page 170

Adding instruments using the palette
Instruments are added using a node's context menu (for more information, see “Adding instruments” on page 19).

Resolving naming conflicts
Names of new components (such as instruments and parameters) cannot be the same as those in the active
configuration. If any names are the same, they must be renamed through the Renaming Rules pane. Select Use
Automatic Renaming Rules to have names automatically assigned or select the Use My Renaming Rules option
(see the following table). 

NOTE:  More than one naming option can be chosen. If all options are selected as in the example column in the 
previous table, new instruments are named MyD03_Acceleration_1, MyD03_Acceleration_2 and so on. Do 
not use quotation marks such as "MyD03_" in renaming fields. Quotation marks will cause an error during 
verification.

Add Only the instrument and attached parameters are added; links and packages are not added.

Add With 
Connections

Adds the selected component along with any relevant sub components, see “Add With Con-
nections option” on page 59.

Table 12: Use My Renaming Rules options

Option Description Example

Rename To: Rename components to the requested string Acceleration_

Prepend Text To Name(s) 
recursively:

Add the specified string to the start of all components MyD03_

Append Automatically Gener-
ated Unique ID, if necessary

Add incrementing number to the end of all components #

Table 11: Instruments Palette features (continued)

Feature Description
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Selecting instruments
Instruments are grouped in tabs according to function as shown in the following figure. To find an instrument, click
the appropriate tab. Refer to the Part Reference and description columns to locate the instrument you want.

Figure 69: Available instruments 

NOTE:  Instruments are grouped by function on tabs. If all available instruments are of similar function, only one tab 
is shown.

Customizing the library pane
XidML libraries are XidML configuration files, which can contain any number of chassis and modules. You can save
these files with the intention of importing them into other projects.
If you regularly import components from these *.xidml libraries, then use this tool to add shortcuts to these libraries.

Creating XidML file to use as library
First create the file and save it to a folder such as the library folder.
1. Create a new configuration and add a chassis.
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2. Then continue to add modules and configure them for reuse as shown in the following example screen.

3. Then save the file, for example to the library folder (C:\ACRA\DASStudio\3.X\Libraries) and choose a name 
such as collection.xidml.

Adding collection.xidml file to the Library pane
The collection.xidml file can now be added to the library pane of the Instruments Palette. 
1. To open Instruments Palette, click the Click here to begin button in the Navigator. 

Instruments Palette opens. 

2. Right-click anywhere in the library pane and then click Add Library. 
(You can also click the add (+) and remove (-) buttons at the bottom of the library pane, though you may need 
to move the mouse over them to see them.)

 

3. In the Library dialog box, type a name for the library in the Name field (such as the name of the xidml file to be 
referenced).

...or move mouse over
bottom to see buttons

Right-click
anywhere...
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4. In the Repository Path field, browse to the xidml files and select the collection.xidml file you created in the 
previous section.

5. Choose an icon for the new library and click Save.

The new library is shown in the library pane.

Adding instruments from the library
You can add instruments such as chassis and modules from a library. Or you can add specific PCM or Ethernet
output settings. When you open the library, only instruments or settings that are in context are shown. 

NOTE:  The Instrument Palette has the option to Add or the option to Add With Connections. For more informa-
tion, see “Add With Connections option” on page 59.

Adding a chassis
1. Open the configuration file that you want to add the chassis to.

2. Right-click the overview node and then click Add/Import Instrument. 

Instruments Palette opens. 
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3. Click the collection library and then click the MyKAM_CHS_13U instrument.

4. Click Add With Connections.
The chassis and all attached instruments are added to the project.

Adding a module
1. Open the configuration file that you want to add the module to.

2. Right-click an empty slot and then click Add/Import Instrument. 
(You can also double-click an empty slot.)
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Instruments Palette opens. 

3. Click the collection library and then select an analog module such as the MyKAD_ADC_113_B instrument.
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4. Click Add With Connections.
The module and all attached parameters are added to the project. 

Adding a bus or a subset of parameters from a bus
In this example, we want to add messages into bus 7 of a KAD/ABM/101 module, which we get from the
KAD/ARI/001 bus in the collection library.

NOTE:  For KAD/ARI/001/B link import functionality, refer to “Import” on page 10.

1. Open the configuration file that contains a bus monitor such as a KAD/ABM/101 module.

2. Select the bus monitor in the Navigator and then click the Packages tab.

3. In the Channels pane, select bus 7 and then click the Import Package button.
Instruments Palette opens. 
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4. Click the collection library.
All ARINC messages in the KAD/ARI/001/B module are shown.

5. Select specific or all messages and then click Add.
The ARINC messages are added to the current configuration.
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Adding PCM settings
In this example, we want to add pre-defined PCM settings from the collection library to a KAD/ENC/005/B module
in the configuration.
1. Open a configuration file that contains a KAD/ENC/005/B module.

2. Select the module in the Navigator and then click the Packages tab.

3. In the Channels pane, select the PCM channel and then Click the Import Package button.
Instruments Palette opens. 

4. Click the collection library.
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5. Select the PCM settings and then click Add.
The PCM settings are added to the current configuration.

NOTE:  Package content such as PCM or IENA cannot be imported; only settings can be imported. Therefore, 
you can only use Add to import and not Add With Connections.

Removing a library shortcut
• To remove a library shortcut, right-click it and then click Remove.

Customizing the user interface
To customize the UI for specific modules (or to add your own) you add XdefML files to a Custom directory. The
Custom directory must be created in the following location:
<InstallDirectory>\XdefML\Custom 
Using the XdefML files in the Custom directory, you can then override configuration options in the standard XdefML
files. 
Typical uses for customizing an XdefML file include the following:
• Reducing the number of options available for a configuration option (called a Setting in XidML)

• Fixing the value of configuration options so they cannot be changed

• Hiding configuration options
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Using a custom XdefML file
1. Copy the XdefML file for the module in question from the Standard XdefML directory to the Custom directory. 

2. Modify the XdefML file.

3. Restart DAS Studio 3.
By default, DAS Studio 3 checks for any XdefML files in the Custom directory and loads them in preference to 
the file in the Standard directory.

To resort to the original XdefML file
If you want to resort to using an XdefML file in its original configuration, then remove the copy from the Custom
directory.
1. Remove the XdefML file for the module in question from the Custom directory. 

2. Restart DAS Studio 3.
As there is no longer a customized XdefML file in the Custom directory, DAS Studio 3 loads the file from the 
Standard directory.

Using the XDefML Instrument Import tool
This setting is used to facilitate adding instruments to the New ACRA Component library (see “Adding new
parameters from the New ACRA Component library” on page 124).
To use the XDefML Instrument Import tool.
1. On the Tools menu, click XDefML Instrument Import.

A browse dialog opens at the default folder you specified in the Options dialog box. (See “Instrument Import” 
on page 14.)
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2. Click OK. 
Available XDefML files are displayed.

NOTE:  The Instrument Import Tool does not allow an instrument (XDefML file) to be imported if it already 
exists in the New ACRA Component library. Nor will it modify existing instruments.

3. Select the files you want and then click Add.

Selected instruments are added to the New ACRA Component library and associated XDefML and HDefML 
files are copied to the XDefML and HDefML folders respectively in DAS Studio 3. 

Changes to the New ACRA Component library are automatically saved and—provided at least one instrument 
was added—the following dialog box appears. 

4. Click OK and restart DAS Studio 3 to apply the changes.



This page is intentionally blank
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Chapter 19
LINKS - CONNECTING INSTRUMENTS

Links represent the physical connections between channels on instruments in a system. When a link is attached to
a channel, the name of the link appears beside the channel in the Navigator (see “Connecting instruments” on
page 21). To connect two channels together, select the unconnected channel in the other instrument and use the
Connect dialog box option to connect the channels (see “Connecting instruments” on page 174). 
All palette features are described in the following table. 

Figure 70: Links Palette overview

Table 13: Links Palette features

Feature Description

New ACRA 
Component

Displays a library of compatible links. In this library, link properties are read only; properties can 
be modified after they are added under the Packages tab.

Import Displays compatible links from an external configuration file.

Links table Displays compatible links from the specified source. This table supports column filtering; see 
“Filtering and sorting parameters” on page 180.

Renaming 
Rules pane

Rename the parameter or accept the default; see “Resolving naming conflicts” on page 160.

Links table

Renaming Rules

Palette 
commands

Libraries

Copying Rules
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Using Links
Links can only be added under channel group icons: ; ; .
This chapter includes the following tasks:
• “Connecting instruments” on page 174

• “Links Palette” on page 175

Connecting instruments 
1. Do one of the following:

 •  In the Navigator, right-click the link that you want to connect to and then click Connect.

 •  In the Packages tab, click the Connect Channel button.

Copying rules Allows multiple instances of a component to be added. This field is unavailable when its use 
could cause a configuration conflict.

Add Only the package is added; its link and attached parameters are not added.

Add With 
Connections

Adds the selected component along with any relevant sub components, see “Add With Con-
nections option” on page 59.

Table 13: Links Palette features (continued)

Feature Description
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2. The Connect dialog box appears showing compatible links in the current configuration.

3. Select the link and click Connect.
The link is added. In this example, an Ethernet link is added from the PC to the KAD/BCU/140.

To remove or disconnect a link, see “Removing links and disconnecting channels” on page 62.

Links Palette
Refer to the following to manually attach or import a link to a channel:

NOTE:  This is not the preferred method of connecting modules, instead we recommend using the method shown in 
“Connecting instruments” on page 174.

1. In the Navigator, right-click the unconnected channel where you want to add a link, click Advanced and then 
click Add Link.

Link from PC to 
controller
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The Links Palette opens.

 

2. Do one of the following:

 •  To create a new link, select the link and then click Add.

 •  To import a link, click Import and then select the configuration file to import the link from. Then select the link 
and click Add.
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Chapter 20
PACKAGES PALETTE - ADDING AND SELECTING PACKAGES

As shown in the following figure, the Packages Palette dialog box contains a library pane from where the source
library or configuration file is selected (only libraries that are in context are shown). The packages table shows
compatible packages from the specified source. The palette commands are used to add the selected packages,
while the Renaming Rules pane is used to specify the naming strategies or to resolve naming conflicts. All palette
features are described in the following table.

Figure 71: Packages Palette overview

Table 14: Packages Palette features

Feature Description

New ACRA 
Component

Displays a library of compatible packages. In this library, package properties are read only; 
properties can be modified after they are added under the Packages tab.

This File Displays compatible packages from the active configuration. (Icon not shown above.)

Import Displays compatible packages from an external configuration file.

Packages 
table

This table supports column filtering; see “Filtering and sorting parameters” on page 180.

Renaming 
Rules pane

Rename the package or accept the default; see “Resolving naming conflicts” on page 160.

Packages table

Renaming Rules

Palette commands

Libraries in context shown
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Using Packages Palette
Packages Palette is accessed from the Packages tab or by right-clicking on a channel in the Navigator. 
This chapter includes the following tasks:
• “Adding packages using the palette” on page 178

• “Selecting packages” on page 178

Adding packages using the palette
A link must be attached to a channel before a package can be added (see “Connecting instruments” on page 21).
If there is no link attached to the channel and you try to add a package, one is added automatically (see “Adding
packages from the Navigator” on page 60).

Selecting packages
The type of packages displayed in the Packages Palette dialog box depends on the type of link that is in context.
For example, if an Ethernet link attached to an SSR/CHS/002 instrument is in context, Packages Palette displays
only IENA (see the following figure) or iNET-X (see Figure 73) Ethernet packages.

Figure 72: Available IENA Ethernet packages

Figure 73: Available iNET-X Ethernet packages

Add Only the package is added; its link and attached parameters are not added, see “Add With 
Connections option” on page 59.

Add With 
Connections

Adds the selected component along with any relevant sub components.

Table 14: Packages Palette features (continued)

Feature Description
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Chapter 21
PARAMETERS PALETTE - ADDING, FILTERING, AND SORTING 
PARAMETERS

As shown in the following figure, the Parameters Palette dialog box contains a library pane from where the source
library or configuration file is selected (only libraries that are in context are shown). The parameter table shows
compatible parameters from the specified source. The palette commands are used to add the selected parameter,
while the Renaming Rules pane is used to specify the naming strategies or to resolve naming conflicts. All palette
features are described in the following table.

Figure 74: Parameters Palette overview

Table 15: Parameters Palette features

Feature Description

New ACRA 
Component

Displays a library of compatible parameters. In this library, parameter properties are read only; 
properties can be modified after they are added under the Parameters pane.

This File Displays compatible parameters from the active configuration. (Icon not shown above.)

Import Displays compatible parameters from an external configuration file.

Parameter 
table

This table supports column filtering; see “Filtering and sorting parameters” on page 180.

Parameter table

Renaming Rules

Palette 
commands

Libraries in context shown
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Using Parameters Palette
Parameters Palette is accessed from the Packages tab or the Processes tab.
This chapter includes the following tasks:
• “Adding parameters using the palette” on page 180

• “Filtering and sorting parameters” on page 180

Adding parameters using the palette
For information on adding parameters, see “Adding existing parameters from the This File library” on page 123,
“Adding existing parameters from the This File library” on page 123, and “Reading package tags” on page 148.

Filtering and sorting parameters
As shown in the following figure and the example that follows, you can use filtering and sorting to find parameters
of interest.

Renaming 
Rules pane

Rename the parameter or accept the default; see “Resolving naming conflicts” on page 160.

Add Only the package is added; its link and attached parameters are not added.

Add With 
Connections

Adds the selected component along with any relevant sub components, see “Add With Con-
nections option” on page 59.

Table 15: Parameters Palette features (continued)

Feature Description
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Figure 75: Parameters Palette with filtering enabled

1. Click in the column heading to toggle between ascending and descending order.

2. In the column that you want to filter by, click the  icon in the column heading.
The filter text and type fields appear below the column name.

3. In the filter text field, type the string (such as SSR for Solid-State Recorder) that you want to search by. 
(Filtering is case sensitive.)

4. From the filter type drop-down list, select the filter type you want to apply. 

For example, selecting Contains, filters all instruments that contain the example string SSR as shown below. 

Click to enable filter

Click to sort by 
ascending/descending
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Use filters in other columns to further refine your search. For example, use the Bits column to search for 
parameters of a fixed number of bits. All filter conditions must be met for a parameter to appear in the table.

5. To sort filtered results for further analysis, click a column heading.
An arrowhead which indicates ascending or descending order is illustrated in Figure 75 on page 181.
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Chapter 22
PARAMETERS - CHANGING PARAMETER SETTINGS

The Parameters pane displays metadata for all parameters in the configuration. It indicates the instrument
hierarchy from which parameters are sourced. 

Figure 76: Parameters pane overview

Using Parameters
The Parameters pane can be collapsed or expanded by clicking the expand button. Parameters can be sorted in
ascending/descending order by clicking on a table heading. You can also filter to show only specific parameters by
clicking the filtering icon in the column header. See “Filtering and sorting parameters” on page 180.

Figure 77: Parameters pane: expand/collapse/sort/filter

Click to 
expand/collapse

Click table headings to sort 
ascending/descending Click for filtering options 
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Changing parameter settings
You can only change settings in cells that are white. The example here shows how to change the range for a
parameter.
1. Locate the parameter of interest. (Filtering can be used to only show parameters of interest. See “Filtering and 

sorting parameters” on page 180.)

NOTE:  The Range Maximum and Range Minimum columns are always displayed in the Parameters pane; 
there is no option to display Gain and Offset values. Gain and Offset values are only available in the 
Settings tab as shown in “Viewing the Range Maximum, Range Minimum, Gain, and Offset columns” 
on page 98.

2. In the Size In Bits, and Range Maximum/Minimum boxes, enter the setting you want.
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Chapter 23
TIME SEEDER - SETS THE TIME ON A BATTERY BACKUP 
TIME MODULE

Time Seeder is a DAS Studio 3 tool that sets the time of a battery backup time module in a Data Acquisition Unit
(DAU). The time can be user-specified or synchronized to the PC with an accuracy within one second.
During the seeding process, Time Seeder saves the system controller configuration, seeds the time into the
system and reprograms the controller with the original configuration.
A configuration must contain a battery backup time module for Time Seeder to run.
Time Seeder does not support time seeding in a slave PCM DAU.

Figure 78: Time Seeder overview

Using Time Seeder
Before running Time Seeder, ensure the DAU is powered on and the configuration link is connected. In a master
slave Acra KAM-500 PCM configuration the time modules can only be time seeded in the master Acra KAM-500
DAU. Ensure the controller module in your configuration is supported (see the kTimeseed data sheet for supported
controller modules).
1. On the Tools menu, click Time Seeder. 

The Time Seeder dialog box opens.

Time Seeder
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2. Use the up/down arrows to set the communication delay in seconds. (This setting can be used to compensate 
for network delays inherent in the physical network. It should be left at the default value unless the time 
seeding accuracy is not close enough.)

3. Select the time source to use for time seeding:

 •  Select date and time (radio button) - Choose this setting to specify the time to be used when you click Seed. 
Click the drop-down arrow to manually select the time.

 •  PC time (radio button) - Choose this setting to time seed the module with your PC’s time.

4. Click Seed to begin time seeding.

Errors when running Time Seeder
You may see an error message as shown in the following table while running Time Seeder. 

Table 16: Time Seeder error messages

Error message Description/solution

No supported modules found in config-
uration

Ensure the following supported battery backed module is in the con-
figuration: KAM/TCG/105

Windows TFTP client not found. This 
is required for accessing DAU control-
lers....

Install the Windows TFTP component on the PC (see the Installation 
Guide on the DAS Studio 3 User Documentation CD).

Module MyXXX_XXX_XXX was not 
seeded

Failure to time seed the module can be caused by the following:
Hardware failed to program.
Hardware powered down during time seeding cycle.
Time seeding canceled by user.
Check firewall settings; confirm that you are using the correct IP 
address in the configuration.

MyXXX_XXX_XXX is missing a con-
troller.

Add a controller to MyXXX_XXX_XXX DAU.
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Chapter 24
PARAMETER SEARCH - FINDS PARAMETER USAGE IN A 
CONFIGURATION

The Parameter Search tool lists all parameters and where they are used in the currently open configuration file
allowing you to search for a specific parameter.

Figure 79: Parameter Search overview

Using Parameter Search
1. On the Tools menu, click Parameter Search.

The Parameter Search dialog box appears listing all parameters and where they are used in the current 
configuration file.

XidML 3.0
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2. Type the paramter name you want to search for and select the relevant check boxes: Case Sensitive; Whole 
word; Source (source of parameter); Sinks (where parameter is used such as in transmission packages).
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Chapter 25
APPLICATIONS

The Applications menu displays installed applications. The default applications in DAS Studio 3 can be classed as
bus monitor builders or bus monitor import utilities. The applications that are available in this menu vary by
software release. 

Figure 80: Example of installed applications

If one of the applications you require is not installed on your system, contact Curtiss-Wright support (acra-
support@curtisswright.com). 

Builder applications
DAS Studio 3 has bus monitor builder applications for configuring the common avionics busses such as
MIL-STD-1553, ARINC-429 and CAN-Bus. All bus applications share a common look and feel and allow for quick
and easy bus definition.
Only one builder application can be run at a time. Once an application is opened, DAS Studio 3 cannot be
accessed until the application is closed. 
When a builder application is opened through the Applications menu, all instruments supporting this builder are
shown. To open a builder for a single instrument, use the instrument's context menu in the Navigator. 
This section discusses the following topics:
• “Builder application GUI overview” on page 190

• “ABI/ACE-CCDL/ACB Serial Builder” on page 192

• “ARINC-429 Builder” on page 196

• “ARINC-429 Transmission Builder” on page 200

• “FireWire Builder” on page 204

• “CAN-Bus Builder” on page 207

• “Ethernet Builder” on page 212

• “IMB Serial Builder” on page 217

• “MIL-STD-1553 Builder” on page 221

• “Serial Builder” on page 226

• “STANAG-3910 FCS Bus Builder” on page 231

• “STANAG-3910 Builder” on page 234

• “EFABus-Express Builder” on page 239

mailto:acra-support@curtisswright.com
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Builder application GUI overview
As shown in the following figure, all instruments and channels supported by the builder application are displayed in
its Navigator. The Editor panes are context sensitive and are controlled by the active instrument or channel node in
the Navigator. You can also filter to show only specific messages or parameters by clicking the filter icon in the
column header (see “Filtering and sorting parameters” on page 180 for details). Some column headers have a
number base picker, which allows the display unit for each column to be set to binary, hex, decimal, or octal.
However, wildcarding is only supported in binary mode.
Starting with DAS Studio 3.4.7, a Tag Parameters tab is available for bus monitor applications. The Tag Parameters
tab lists all tags that can be used with the message that is currently selected. Use the check boxes to add or
remove tags. When a tag is selected, its Name cell changes to white, allowing it to be renamed.

Figure 81: Sample builder application GUI

Navigator pane

Editor 
panes

Click for filtering 
options

Move to previous/next message

Number base picker

Click to open 
Tag Parameters tab
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Renaming multiple packages or parameters
You can rename multiple packages or parameters in any of the builder applications. 
Refer to the following to rename packages; the same procedure is followed to rename parameters.
1. Select the packages you want to rename. 

If you want numbering to start at the top row, select the bottom item and then while holding the Shift key select 
the top item.

2. Press the F2 key to initiate edit mode on all selected rows. 

3. Type the name for the first package, ensuring the final character is a numeral, for example MyMsg_0.

4. Press the Enter key.
The selected packages are renamed accordingly.

If you do not enter a digit at the end of the first parameter name, then the second parameter in the selection has _0
appended to the name, followed by _1 for the third and so on. 
If you enter a non-zero digit for the first parameter name, for example myParam_15, then the second parameter in
the selection has _16 appended to the name, followed by _17 for the third and so on.

Closing an application
Click the Save button when you want to save your changes to the configuration file without closing the application.
Click the Save & Close button to save your changes to the configuration file and close the application. Click the
Close button to close the application without saving your changes.
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ABI/ACE-CCDL/ACB Serial Builder
The ABI/ACE-CCDL/ACB Serial Builder application is used to add and configure messages and parameters on
ABI/ACE-CCDL/ACB serial bus monitor modules.

Adding messages
Before running this application, ensure you have added a module that supports ABI/ACE-CCDL/ACB serial bus
monitor modules such as the KAD/UBM/104. Otherwise, a “No Supported Serial Parsers Found” message is
displayed.
1. On the Applications menu, click ABI/ACE-CCDL/ACB Serial Builder.

The ABI/ACE-CCDL/ACB Serial Builder 3 dialog box opens.
(For dialog box navigation, see “Builder application GUI overview” on page 190.)

2. To add a message to a channel, select the channel and do one of the following:

 •  To add a single package, click Add Package.

 •  To add multiple packages, type the number of packages in the Add Packages field and then click Add 
Packages. (The maximum number of packages you can add is shown in the field.)
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The packages are added.

3. Change settings for each field as described in Table 17 on page 194.

4. Click Add Message to add additional messages. 
Each additional message is added with the same settings you chose for the previous message.

5. To add messages to other channels, repeat steps 2 to 4 for each channel.

6. To tag a message, select the message and then click the Tag Parameters tab.
Applicable tags for the selected message type are listed.

7. Select the parameters you want to add by clicking each parameter’s Enable check box. (Use the Ctrl key to 
select non-contiguous parameters.)

NOTE:  To add a single parameter, click the Enable check box twice and then skip the next 2 steps.
8. Press the F2 key to initiate edit mode on all selected rows.

9. Enable a check box and press the Enter key; all selected parameters are checked.
(Once selected, a tag can be renamed.)

10. Repeat steps 6 to 9 for other messages you want to tag.

11. To add a parameter to a message, select the message and then do one of the following: 
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 •  To add a single parameter to a message, click Add Parameter. 

 •  To add multiple parameters to a message, type the values you want in the Start Offset Word (the offset into 
the message where the first parameter is placed) and the Word Offset Increment (the offset between 
parameters in a message) fields, then type the number of parameters in the Add Parameters field and then 
click Add Parameters. (The maximum number of parameters that can be added to the message is shown 
in the Add Parameters field.)

The parameters are added.

 

12. Change the Parameter Name field if desired. 
The other fields cannot be changed in the ABI/ACE-CCDL/ACB Serial Builder application.

Table 17: ABI/ACE-CCDL/ACB dialog box settings

Setting Description

Instrument Name of instrument; read-only field.

Channel Name of channel; read-only field.

Package Each package added is assigned a default name with incrementing integer.
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To see the packages in DAS Studio 3, select the KAD/UBM/104 in the Navigator and then click the Packages tab.

Slave Address This is an 8-bit field and is used as part of the message identifier. It is only used 
if the module mode is set to ACB. In other module modes, this field is ignored.

Function Code This selects the function code for a package. Only certain function codes are 
valid for particular module modes. If the function code is invalid, the field is 
highlighted in red and the Save button is disabled until the error is resolved.

Address This is a 16-bit field and is used as a message identifier.

Payload Count Number of parameters attached to the message.

Table 17: ABI/ACE-CCDL/ACB dialog box settings (continued)

Setting Description



196    DAS Studio 3 User Manual (SW/BK/0015 | 13 Sep. 2021)

25

  

ARINC-429 Builder
The ARINC-429 Builder application is used to add and configure messages and parameters on ARINC-429 bus
monitor modules.

Adding messages
Before running this application, ensure you have added a module that supports monitoring of ARINC-429
packages such as the KAD/ABM/101. Otherwise, a “No Supported ARINC-429 Parsers Found” message is
displayed.
1. On the Applications menu, click ARINC-429 Builder.

The ARINC-429 Builder 3 dialog box opens.
(For dialog box navigation, see “Builder application GUI overview” on page 190.)

2. To add a message to a channel, select the channel and do one of the following:

 •  To add a single message, click Add Message.

 •  To add multiple messages, type the number of messages in the Add Messages field and then click Add 
Messages. (The maximum number of messages you can add is shown in the field.)

NOTE:  Starting with DAS Studio 3.4.7, the ARINC-429 Builder has a Payload Parameters tab, making it con-
sistent with other bus monitor applications. Previously the ARINC-429 Builder application created a 32-
bit parameter automatically when a message was added, which meant there was no need to show the 
payload UI for ARINC messages. This was changed in order to support message tagging, which is now 
defined in the Tag Parameters tab.
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The messages are added.

3. Change settings for each field as described in Table 18 on page 198.

4. Click Add Message to add additional messages. 
Each additional message is added with the same settings you chose for the previous message.

5. To add messages to other channels, repeat steps 2 to 4 for each channel.

6. To tag a message, select the message and then click the Tag Parameters tab.
Applicable tags for the selected message type are listed.

7. Select the parameters you want to add by clicking each parameter’s Enable check box. (Use the Ctrl key to 
select non-contiguous parameters.) 

NOTE:  To add a single parameter, click the Enable check box twice and then skip the next 2 steps.
8. Press the F2 key to initiate edit mode on all selected rows.

9. Enable a check box and press the Enter key; all selected parameters are checked.
(Once selected, a tag can be renamed.)

10. Repeat steps 6 to 9 for other messages you want to tag. 

11. Only single parameters can be added to each message.
To add a parameter to a message, click Add Parameter.
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The parameter is added.

12. Change the Parameter Name field if desired. The other fields cannot be changed in the ARINC-429 Builder 
application.

Table 18: ARINC-429 dialog box settings

Setting Description

Instrument Name of instrument; read-only field.

Channel Name of channel; read-only field.

Message Each message added is assigned a default name with incrementing integer.

Rate Rate of incoming message (Hz). 

Label This is an 8-bit field; value must be between 0 and 255.

SDI This is a 2-bit field in the ARINC header messages; filter for specific messages 
or choose All.

SSM This is a 2-bit field in the ARINC header messages; filter for specific messages 
or choose All.

Payload Count Number of parameters attached to the message.
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Removing messages
1. Select the module to view all messages.

2. To remove a message, select the message (hold the Shift or Ctrl key to select multiple messages) and then 
click Remove Message. (Clear the Confirm Removal check box if you do not want to confirm deletion of 
messages.)

Exiting the application
• When you are finished adding and configuring messages, click Save & Close. 

The messages are saved to the configuration file.

To see the messages in DAS Studio 3, select the KAD/ABM/101 in the Navigator and then click the Packages tab.
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ARINC-429 Transmission Builder
The ARINC-429 Transmission Builder application is used to add and configure messages and parameters on
ARINC-429 bus monitor modules.

Adding messages
Before running this application, ensure you have added a module that supports monitoring of ARINC-429
packages such as the KAD/ARI/002. Otherwise, a “No Supported ARINC-429 Transmitters Found” message is
displayed.
1. On the Applications menu, click ARINC-429 Transmission Builder.

The ARINC-429 Transmission Builder 3 dialog box opens.
(For dialog box navigation, see “Builder application GUI overview” on page 190.)

2. To add a message to a channel, select the channel and do one of the following:

 •  To add a single message, click Add Message.

 •  To add multiple messages, type the number of messages in the Add Messages field and then click Add 
Messages. (The maximum number of messages you can add is shown in the field.)
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The messages are added.

3. Change settings for each field as described in the following table.

Table 19: ARINC-429 Transmission dialog box settings

Setting Description

Instrument Name of instrument; read-only field.

Channel Name of channel; read-only field.

Message Each message added is assigned a default name with incrementing integer.

Rate Rate of incoming message (Hz). 

Label This is an 8-bit field; value must be between 0 and 255.

SDI This is a 2-bit field in the ARINC header messages.

SSM This is a 2-bit field in the ARINC header messages.

Sequence Number Indicates the order that the message is transmitted on the ARINC bus; 0 is the 
highest priority.

Payload Count Number of parameters attached to the message.
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Selecting parameters for transmission
1. Select the message that you want to add the parameter to.

2. Select the parameter that you want to add.

3. Type the values you want in the Start Offset Bit (the offset into the message where the first parameter is 
placed) and the Bit Offset Increment (the offset between parameters in a message) fields and then click Add.
The parameter is added.

NOTE:  It is not possible to add another parameter to this message as doing so would exceed the available 
payload capacity.
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Removing messages
1. Select the module to view all messages.

2. To remove a message, select the message (hold the Shift or Ctrl key to select multiple messages) and then click 
Remove Message. (Clear the Confirm Removal check box if you do not want to confirm deletion of messages.)

Exiting the application
• When you are finished adding and configuring messages, click Save & Close. 

The messages are saved to the configuration file.

To see the messages in DAS Studio 3, select the KAD/ARI/002 in the Navigator and then click the Packages tab.
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FireWire Builder
The FireWire Builder application is used to add and configure messages and parameters on FireWire S100b bus
monitor parser modules.

Adding packages and parameters
Before running this application, ensure you have added a module that supports FireWire packages such as the
KAD/FBM/105. Otherwise, a “No Supported FireWire-Bus Parsers Found” message is displayed.
1. On the Applications menu, click FireWire Builder.

The FireWire Builder 3 dialog box opens.
(For dialog box navigation, see “Builder application GUI overview” on page 190.)

2. To add a package to a link, select the link and then do one of the following:

 •  To add a single package, click Add Package.

 •  To add multiple packages, type the number of packages in the Add Packages field and click Add 
Packages. (The maximum number of packages that can be added is shown in the Add Packages field.)

The packages are added. 

3. Change settings for each field as described in Table 20 on page 206.
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4. To tag a message, select the message and then click the Tag Parameters tab.
Applicable tags for the selected message type are listed.

5. Select the parameters you want to add by clicking each parameter’s Enable check box. (Use the Ctrl key to 
select non-contiguous parameters.)

NOTE:  To add a single parameter, click the Enable check box twice and then skip the next 2 steps.
6. Press the F2 key to initiate edit mode on all selected rows.

7. Enable a check box and press the Enter key; all selected parameters are checked.
(Once selected, a tag can be renamed.)

8. Repeat steps 4 to 7 for other messages you want to tag.

9. To add parameters to a package, select the package and then do one of the following:

 •  To add a single parameter to a package, click Add Parameter. 

 •  To add multiple parameters to a package, type the values you want in the Start Offset Word (the offset into 
the message where the first parameter is placed) and the Word Offset Increment (the offset between 
parameters in a message) fields, then type the number of parameters in the Add Parameters field and click 
Add Parameters. (The maximum number of parameters that can be added to the package is shown in the 
Add Parameters field.)

The parameters are added.
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The Parameter Count indicates the number of parameters that have been added; the Add Parameters 
field indicates the number of parameters that can still be added.

10. Change the Parameter Name field if desired. 
The other fields cannot be changed in the FireWire Builder application.

Removing packages and parameters
1. Select the link that you want to delete the package or parameter from.

Table 20: Package settings

Setting Description

Instrument Name of instrument; read-only field.

Channel Name of channel; read-only field.

Package Each package added is assigned a default name with incrementing integer.

QuadletA/B/C/D/E/F A quadlet is a 32-bit FireWire data word. Up to six quadlets can be set as a 
unique message identifier.

Payload count Number of parameters attached to the package.
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2. Do one of the following:

 •  To remove a package:
Select the package (hold the Shift or Ctrl key to select multiple packages) and then click Remove 
Package. (Clear the Confirm Removal check box if you do not want to confirm deletion of packages.)
The packages and any attached parameters are removed.

 •  To remove a parameter:
Select the parameter (hold the Shift or Ctrl key to select multiple parameters) and then click Remove 
Parameter. (Clear the Confirm Removal check box if you do not want to confirm deletion of parameters.)
The parameters are removed.

Exiting the application
• When you are finished adding and configuring packages and parameters, click Save & Close. 

The changes are saved to the configuration file.

To see the packages and parameters, select the KAD/FBM/105 in the Navigator and then click the Packages tab.

CAN-Bus Builder
The CAN-Bus Builder application is used to add and configure messages and parameters on CAN-Bus monitor
modules.

Adding messages and parameters
Before running this application, ensure you have added a module that supports monitoring of CAN-Bus messages
such as the KAD/CBM/102. Otherwise, a “No Supported CAN-Bus Parsers Found” message is displayed.
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1. On the Applications menu, click CAN-Bus Builder.

The CAN-Bus Builder 3 dialog box opens.
(For dialog box navigation, see “Builder application GUI overview” on page 190.)

2. To add a message to a channel, select the channel and then do one of the following: 

 •  To add a single message, click Add Message.

 •  To add multiple messages, type the number of messages in the Add Messages field and then click Add 
Messages. (The maximum number of messages that can be added is shown in the Add Messages field.)

The messages are added. 

3. Change settings for each field as described in Table 21 on page 210.
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4. Click the Number base picker arrow to change the display units. 
Wildcarding is only supported in binary mode.

5. Click Add Message to add additional messages. 
Each additional message is added with the same settings you chose for the previous message. One of these 
settings must be changed to uniquely identify the new message.

6. To add messages to other channels, repeat steps 2 to 5 for each channel.

7. To tag a message, select the message and then click the Tag Parameters tab.
Applicable tags for the selected message type are listed.

8. Select the parameters you want to add by clicking each parameter’s Enable check box. (Use the Ctrl key to 
select non-contiguous parameters.)

NOTE:  To add a single parameter, click the Enable check box twice and then skip the next 2 steps.
9. Press the F2 key to initiate edit mode on all selected rows.

10. Enable a check box and press the Enter key; all selected parameters are checked.
(Once selected, a tag can be renamed.)

11. Repeat steps 4 to 7 for other messages you want to tag.

12. To add a parameter to a message, select the message and then do one of the following: 

 •  To add a single parameter to a message, click Add Parameter. 

 •  To add multiple parameters to a message, type the values you want in the Start Offset Word (the offset into 
the message where the first parameter is placed) and the Word Offset Increment (the offset between 
parameters in a message) fields, then type the number of parameters in the Add Parameters field and then 
click Add Parameters. (The maximum number of parameters that can be added to the message is shown 
in the Add Parameters field.)
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The parameter is added.

13. Change the Parameter Name field if desired. 
The other fields cannot be changed in the CAN-Bus Builder application.

Table 21: Message settings

Setting Description

Instrument Name of instrument; read-only field.

Channel Name of channel; read-only field.

Message Each message added is assigned a default name with incrementing integer.

ID Mode Toggles between SID mode and Extended ID mode.

SID Specifies Standard Identifier value to parse on.

Ext ID Specifies Extended Identifier value to parse on.

IDE Indicates ID parsing mode.

DLC Specifies Data Length Code value to parse on.

Data Specifies first 32 bits of the CAN-Bus message to parse on.

Payload Count Number of parameters attached to the package.
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Removing messages and parameters
1. Select the channel that you want to delete the message or parameter from.

2. Do one of the following:

 •  To remove messages:
Select the messages (hold the Shift or Ctrl keys to select multiple frames) and then click Remove 
Message. (Clear the Confirm Removal check box if you do not want to confirm deletion of messages.)
The messages and any attached parameters are removed.

 •  To remove a parameter:
Select the parameters (hold the Shift or Ctrl keys to select multiple parameters) and then click Remove 
Parameter. (Clear the Confirm Removal check box if you do not want to confirm deletion of parameters.)
The parameters are removed.

Exiting the application
• When you are finished adding and configuring messages and parameters, click Save & Close. 

The changes are saved to the configuration file.



212    DAS Studio 3 User Manual (SW/BK/0015 | 13 Sep. 2021)

25

  

To see the messages and parameters, select the KAD/CBM/102 in the Navigator and then click the Packages tab.

Ethernet Builder
The Ethernet Builder application is used to add and configure Ethernet messages and parameters on Ethernet bus
monitor modules. The instrument must be configured for generic parsing definition as the application does not
support IENA or iNET-X packages.

Adding frames and parameters
Before running this application, ensure you have added a module that supports Ethernet frames such as the
KAD/EBM/101/B. Otherwise, a “No Supported Ethernet Parsers Found” message is displayed. 
1. On the Settings tab, ensure the Traffic Type is set to Generic.
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2. On the Applications menu, click Ethernet Builder.

The Ethernet Builder 3 dialog box opens.
(For dialog box navigation, see “Builder application GUI overview” on page 190.)

3. To add a frame to a link, select the link and then do one of the following:

 •  To add a single frame, click Add Frame.

 •  To add multiple frames, type the number of frames in the Add Frames field and then click Add Frames. 
(The maximum number of frames that can be added is shown in the Add Frames field.)

The frames are added. 

4. Select the frame size from the Parameter Size In Bits drop-down menu.
Frames can be 16, 32, 48 or 64 bits.

5. Click Add Parameters to add a parameter of the selected size.



214    DAS Studio 3 User Manual (SW/BK/0015 | 13 Sep. 2021)

25

  

6. Click the Classifier Label arrow in each column header to change how parsing is carried out.
Hold the mouse pointer over each setting for tooltips on the setting.

7. Click the Number base picker arrow to change the display units. 
Wildcarding is only supported in binary mode.

8. Click Add Frame to add additional frames. 
Each additional frame is added with the same settings you chose for the previous frame. One of these settings 
must be changed to uniquely identify the new frame.

9. To tag a frame, select the frame and then click the Tag Parameters tab.
Applicable tags for the selected frame type are listed.

10. Select the parameters you want to add by clicking each parameter’s Enable check box. (Use the Ctrl key to 
select non-contiguous parameters.)

NOTE:  To add a single parameter, click the Enable check box twice and then skip the next 2 steps.
11. Press the F2 key to initiate edit mode on all selected rows.

Classifier Label

Mouse over tooltip for each setting
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12. Enable a check box and press the Enter key; all selected parameters are checked.
(Once selected, a tag can be renamed.)

13. Repeat steps 7 to 10 for other frames you want to tag.

14. To add parameters to a frame, select the frame and then do one of the following:

 •  To add a single parameter to a frame, click Add Parameter. 

 •  To add multiple parameters to a frame, type the values you want in the Start Offset Word (the offset into the 
message where the first parameter is placed) and the Word Offset Increment (the offset between 
parameters in a message) fields, then type the number of parameters in the Add Parameters field and then 
click Add Parameters. (The maximum number of parameters that can be added to the frame is shown in 
the Add Parameters field.)

The parameters are added.

The Parameter Count indicates the number of parameters that have been added; the Add Parameters field 
indicates the number of parameters that can still be added.

15. Change the Parameter Name field if desired. 
The other fields cannot be changed in the Ethernet Builder application.

Table 22: Frame settings

Setting Description

Instrument Name of instrument; read-only field.

Channel Name of channel; read-only field.

Frame Each frame added is assigned a default name with incrementing integer.
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Removing frames and parameters
1. In the Navigator pane, select the link that you want to delete the frames or parameters from.

2. Do one of the following:

 •  To remove frames:
Select the frames (hold the Shift or Ctrl keys to select multiple frames) and then click Remove Frame. 
(Clear the Confirm Removal check box if you do not want to confirm deletion of frames.)
The frames and any attached parameters are removed.

 •  To remove parameters:
Select the parameters (hold the Shift or Ctrl keys to select multiple parameters) and then click Remove 
Parameter. (Clear the Confirm Removal check box if you do not want to confirm deletion of parameters.)
The parameters are removed.

Exiting the application
• When you are finished adding and configuring frames and parameters, click Save & Close. 

The changes are saved to the configuration file.

Offset Classifier As shown in the drop-down list, each column can be customized to parse at dif-
ferent locations in the Ethernet frame.
See the mouse over tooltips for information on each setting.

Payload Count Number of parameters attached to the frame.

Table 22: Frame settings (continued)

Setting Description
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To see the frames and parameters, select the KAD/EBM/101/B in the Navigator and then click the Packages tab.

IMB Serial Builder
The IMB Serial Builder application is used to add and configure messages and parameters on IMB serial bus
monitor modules.

Adding messages
Before running this application, ensure you have added a module that supports IMB serial bus monitor modules
such as the KAD/IBM/101. Otherwise, a “No Supported Serial Parsers Found” message is displayed.
1. On the Applications menu, click IMB Serial Builder.

The IMB Serial Builder 3 dialog box opens.
(For dialog box navigation, see “Builder application GUI overview” on page 190.)

2. To add a message to a channel, select the channel and do one of the following:

 •  To add a single package, click Add Package.

 •  To add multiple packages, type the number of packages in the Add Packages field and then click Add 
Packages. (The maximum number of packages you can add is shown in the field.)
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The packages are added.

3. Change settings for each field as described in Table 23 on page 220.

4. Click Add Message to add additional messages. 
Each additional message is added with the same settings you chose for the previous message.

5. To add messages to other channels, repeat steps 2 to 4 for each channel.
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6. To tag a message, select the message and then click the Tag Parameters tab.
Applicable tags for the selected message type are listed.

7. Select the parameters you want to add by clicking each parameter’s Enable check box. (Use the Ctrl key to 
select non-contiguous parameters.)

NOTE:  To add a single parameter, click the Enable check box twice and then skip the next 2 steps.
8. Press the F2 key to initiate edit mode on all selected rows.

9. Enable a check box and press the Enter key; all selected parameters are checked.
(Once selected, a tag can be renamed.)

10. Repeat steps 6 to 9 for other messages you want to tag.

11. To add a parameter to a message, select the message and then do one of the following: 

 •  To add a single parameter to a message, click Add Parameter. 

 •  To add multiple parameters to a message, type the values you want in the Start Offset Word (the offset into 
the message where the first parameter is placed) and the Word Offset Increment (the offset between 
parameters in a message) fields, then type the number of parameters in the Add Parameters field and then 
click Add Parameters. (The maximum number of parameters that can be added to the message is shown 
in the Add Parameters field.)
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The parameters are added.

 

12. Change the Parameter Name field if desired. 
The other fields cannot be changed in the IMB Serial Builder application.

Table 23: IMB dialog box settings

Setting Description

Instrument Name of instrument; read-only field.

Channel Name of channel; read-only field.

Package Each package added is assigned a default name with incrementing integer.

Label This is an 8-bit field; value must be between 0 and 255.

Payload Count Number of parameters attached to the message.
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To see the packages in DAS Studio 3, select the KAD/IBM/101 in the Navigator and then click the Packages tab.

MIL-STD-1553 Builder
The MIL-STD-1553 Builder application is used to add message definitions for the purpose of specifying parsing
conditions for MIL-STD-1553 messages on the bus.

Adding messages and parameters
Before running this application, ensure you have added a module that supports MIL-STD-1553 messages such as
the KAD/MBM/101. Otherwise, a “No Supported MIL-STD-1553 Parsers Found” message is displayed.
1. On the Applications menu, click MIL-STD-1553 Builder.

The MIL-STD-1553 Builder 3 dialog box opens.
(For dialog box navigation, see “Builder application GUI overview” on page 190.)

2. To add a message to a link, select the link and then do one of the following:

 •  To add a single message, click Add Message.

 •  To add multiple messages, type the number of messages in the Add Messages field and then click Add 
Messages. (The maximum number of messages that can be added is shown in the Add Messages field.)
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The messages are added. 

3. Change settings for each field as described in Table 24 on page 224.
The message type determines the active settings. For example, a Bus Controller to Remote Terminal does not 
have a Source Remote Terminal or Source Sub Address setting and these settings are inactive.

4. Click Add Message to add additional messages. 
Each additional message is added with the same settings you chose for the previous message. One of these 
settings must be changed to uniquely identify the new message.
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5. To tag a message, select the message and then click the Tag Parameters tab.
Applicable tags for the selected message type are listed.

6. Select the parameters you want to add by clicking each parameter’s Enable check box. (Use the Ctrl key to 
select non-contiguous parameters.)

NOTE:  To add a single parameter, click the Enable check box twice and then skip the next 2 steps.
7. Press the F2 key to initiate edit mode on all selected rows.

8. Enable a check box and press the Enter key; all selected parameters are checked.
(Once selected, a tag can be renamed.)

9. Repeat steps 5 to 8 for other messages you want to tag.

10. To add parameters to a message, select the message and then do one of the following:

 •  To add a single parameter to a message, click Add Parameter. 

 •  To add multiple parameters to a message, type the values you want in the Start Offset Word (the offset into 
the message where the first parameter is placed) and the Word Offset Increment (the offset between 
parameters in a message) fields, then type the number of parameters in the Add Parameters field and click 
Add Parameters. (The maximum number of parameters that can be added to the message is shown in the 
Add Parameters field.)

The parameters are added.



224    DAS Studio 3 User Manual (SW/BK/0015 | 13 Sep. 2021)

25

  

The Parameter Count indicates the number of parameters that have been added; the Add Parameters 
field indicates the number of parameters that can still be added.

11. Change the Parameter Name field if desired. The other fields cannot be changed in the MIL-STD-1553 
Builder application.

12. To add a variant message to a package, select the package and then click the Variant Messages tab.

NOTE:  Variants are only supported in the following 1553 bus monitors: KAD/MSB/103, KAD/MBM/101, 
KAD/MBM/102, AXN/MBM/401, and AXN/MBM/402.

13. Click the Add Variant button.
The variant message is added.

Table 24: Message settings

Setting Description

Instrument Name of instrument; read-only field.

Channel Name of channel; read-only field.

Message Name Each message added is assigned a default name with incrementing integer.

Type The following options are available:
BC to RT (bus controller to remote terminal)
BC to all RT’s (bus controller to all remote terminals)
RT to BC (remote terminal to bus controller)
RT to RT (remote terminal to remote terminal)
RT to all RT’s (remote terminal to all remote terminals)
Mode no data
Mode transmit data
Mode receive data
Broadcast mode no data
Broadcast mode receive data

Number of Variants The number of variant or shared messages. These are messages stored in the 
same memory as an existing message. When a message has a payload param-
eter it can have variant messages attached to it. These variant messages can-
not be existing messages and they cannot have payload parameters. When a 
variant message is received it is stored in the same memory as its parent mes-
sage, that is, the message with payload parameters.

Source Remote Terminal Remote terminal address of the message's source.
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Removing messages and parameters
1. Select the link that you want to delete the message or parameter from.

2. Do one of the following:

 •  To remove messages:
Select the messages (hold the Shift or Ctrl key to select multiple messages) and then click Remove 
Message. (Clear the Confirm Removal check box if you do not want to confirm deletion of messages.)
The messages and any attached parameters are removed.

 •  To remove parameters:
Select the parameters (hold the Shift or Ctrl key to select multiple parameters) and then click Remove 
Parameter. (Clear the Confirm Removal check box if you do not want to confirm deletion of parameters.)
The parameters are removed.

Exiting the application
• When you are finished adding and configuring messages and parameters, click Save & Close. 

The changes are saved to the configuration file.

Source Sub Address Sub address in the message's source remote terminal.

Destination Remote Terminal Remote terminal address of the message's destination.

Destination Sub Address Sub address in the message's destination remote terminal.

Number Of Data Words Number of data words when message is not a mode code.

Mode Code Mode code number when message is a mode code.

Payload Count Number of parameters attached to the message.

Table 24: Message settings (continued)

Setting Description
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To see the messages and parameters, select the KAD/MBM/101 in the Navigator and then click the Packages tab.

Serial Builder
The Serial Builder application is used to add and configure messages and parameters on RS-232, RS-422 and
RS-485 serial bus monitor modules.

Adding packages and parameters
Before running this application, ensure you have added a module that supports serial packages such as the
KAD/UAR/102. Otherwise, a “No Supported Serial Parsers Found” message is displayed.
1. On the Applications menu, click Serial Builder.

The Serial Builder 3 dialog box opens.
(For dialog box navigation, see “Builder application GUI overview” on page 190.)

2. To add a package to a link, select the link and then do one of the following:

 •  To add a single package, click Add Package.

 •  To add multiple packages, type the number of packages in the Add Packages field and click Add 
Packages. (The maximum number of packages that can be added is shown in the Add Packages field.)
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The packages are added. 

3. Change settings for each field as described in Table 25 on page 228.

4. To tag a package, select the package and then click the Tag Parameters tab.
Applicable tags for the selected package type are listed.

5. Select the parameters you want to add by clicking each parameter’s Enable check box. (Use the Ctrl key to 
select non-contiguous parameters.)

NOTE:  To add a single parameter, click the Enable check box twice and then skip the next 2 steps.
6. Press the F2 key to initiate edit mode on all selected rows.

7. Enable a check box and press the Enter key; all selected parameters are checked.
(Once selected, a tag can be renamed.)

8. Repeat steps 4 to 7 for other packages you want to tag.

9. To add parameters to a package, select the package and then do one of the following:



228    DAS Studio 3 User Manual (SW/BK/0015 | 13 Sep. 2021)

25

  

 •  To add a single parameter to a package, click Add Parameter. 

 •  To add multiple parameters to a package, type the values you want in the Start Offset Word (the offset into 
the message where the first parameter is placed) and the Word Offset Increment (the offset between 
parameters in a message) fields, then type the number of parameters in the Add Parameters field and click 
Add Parameters. (The maximum number of parameters that can be added to the package is shown in the 
Add Parameters field.)

The parameters are added.

The Parameter Count indicates the number of parameters that have been added; the Add Parameters 
field indicates the number of parameters that can still be added.

10. Change the Parameter Name field if desired. 
The other fields cannot be changed in the Serial Builder application.

Table 25: Package settings

Setting Description

Instrument Name of instrument; read-only field.

Channel Name of channel; read-only field.

Package Each package added is assigned a default name with incrementing integer.

Parsing Mode Message storage criteria: Bytes/Package; Start/Stop Sequence; or Stop 
Sequence Only. When Stop Sequence Only is selected, Bytes Per Package, 
Start Sequence Format and Start Sequence settings are disabled.

Bytes Per Package Number of bytes in the message used to determine when a message ends.

Start Sequence Format Format for the start sequence; format must be either Hex, Binary or ASCII.
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Removing packages and parameters
1. Select the link that you want to delete the package or parameter from.

2. Do one of the following:

 •  To remove a package:
Select the package (hold the Shift or Ctrl key to select multiple packages) and then click Remove 
Package. (Clear the Confirm Removal check box if you do not want to confirm deletion of packages.)
The packages and any attached parameters are removed.

 •  To remove a parameter:
Select the parameter (hold the Shift or Ctrl key to select multiple parameters) and then click Remove 
Parameter. (Clear the Confirm Removal check box if you do not want to confirm deletion of parameters.)
The parameters are removed.

Start Sequence String value used to identify the start of a message to be parsed. 
Note: The start sequence of characters needs to be taken into account in the 
message data. In other words, the start sequence of characters is on Word Off-
set position 0 in the Parameters section.

Stop Sequence Format Format for the stop sequence; format must be either Hex, Binary or ASCII.

Stop Sequence String value used to identify the end of a message to be parsed. 
Note: The stop sequence of characters needs to be taken into account in the 
message data. In other words, if the maximum message size is 1024 bytes, 
some of those 1024 bytes need to be allocated for the stop sequence at the end 
of the message. 

Payload count Number of parameters attached to the package.

Table 25: Package settings (continued)

Setting Description
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Parsing RS messages in hexadecimal and binary format 
In addition to parsing messages in ASCII, you can also use the Serial Builder application to configure a
KAD/UAR/102 to parse RS-232, RS-485 and RS-422 messages in hexadecimal and binary format. 
1. Open the Serial Builder application and add a package. 

For more information, see “Adding packages and parameters” on page 226.

2. To change the Start Sequence Format value of a message, double-click in the message cell to access a 
drop-down menu and select Binary or Hex.

For information on fields which can be edited, see Table 25 on page 228.

NOTE:   Serial Builder supports wild cards '**' in the Start Sequence. Two wild card characters are required 
which must be on word (2-byte) boundaries and the Start Sequence Format has to be Hex.

3. To change the Stop Sequence Format value of a message, double-click to access a drop-down menu. and 
select Binary or Hex.
The selected format is then displayed in both Start Sequence Format and Stop Sequence Format cells.

4. Double-click in each cell to change the Start Sequence and the Stop Sequence values.

TIP!    For example, to insert a hexadecimal value for Start of Message (STX), type 2 in the Start Sequence 
field. To insert a hexadecimal value for End of Message (ETX), type 3 in the Stop Sequence field.

5. Add the number of parameters, and word index, that you want the KAD/UAR/102 to parse. 
For more information, see “Adding packages and parameters” on page 226.

Exiting the application
• When you are finished adding and configuring packages and parameters, click Save & Close. 

The changes are saved to the configuration file.
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To see the packages and parameters, select the KAD/UAR/102 in the Navigator and then click the Packages tab.

STANAG-3910 FCS Bus Builder
The STANAG-3910 FCS Bus Builder application is used to add and configure messages and parameters on
STANAG-3910 FCS bus monitor modules.

Adding packages and parameters
Before running this application, ensure you have added a module that supports STANAG-3910 such as the
KAM/FBM/001. Otherwise, a “No Supported STANAG-3910 Parsers Found” message is displayed.
1. On the Applications menu, click STANAG-3910 FCS Bus Builder.

The STANAG-3910 FCS Bus Builder 3 dialog box opens.

2. To add a package to a link, select the link and then do one of the following:

 •  To add a single package, click Add Package.

 •  To add multiple packages, type the number of packages in the Add Packages field and click Add 
Packages. (The maximum number of packages that can be added is shown in the Add Packages field.)
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The packages are added. 

3. Change settings for each field as described in Table 26 on page 233.

4. To tag a package, select the package and then click the Tag Parameters tab.
Applicable tags for the selected package type are listed.

5. Select the parameters you want to add by clicking each parameter’s Enable check box. (Use the Ctrl key to 
select non-contiguous parameters.)

NOTE:  To add a single parameter, click the Enable check box twice and then skip the next 2 steps.
6. Press the F2 key to initiate edit mode on all selected rows.

7. Enable a check box and press the Enter key; all selected parameters are checked.
(Once selected, a tag can be renamed.)

8. Repeat steps 4 to 7 for other packages you want to tag.



CHAPTER 25: APPLICATIONS     233

  

9. To add parameters to a package, select the package and then click Add Parameter. 

Removing packages and parameters
1. Select the link that you want to delete the package or parameter from.

2. Do one of the following:

 •  To remove a package:
Select the package (hold the Shift or Ctrl key to select multiple packages) and then click Remove 

Table 26: Package settings

Setting Description

Instrument Name of instrument; read-only field.

Channel Name of channel; read-only field.

Package Name Each package added is assigned a default name with incrementing integer.

FCS Frame Position Setting used to configure the position in the package where the data is to be 
read.

Payload count Number of parameters attached to the package.
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Package. (Clear the Confirm Removal check box if you do not want to confirm deletion of packages.)
The packages and any attached parameters are removed.

 •  To remove a parameter:
Select the parameter and then click Remove Parameter. (Clear the Confirm Removal check box if you do 
not want to confirm deletion of parameters.)
The parameter is removed.

Exiting the application
• When you are finished adding and configuring packages and parameters, click Save & Close. 

The changes are saved to the configuration file.

To see the packages and parameters, select the KAM/FBM/001/B in the Navigator and then click the Packages
tab.

STANAG-3910 Builder
The STANAG-3910 Builder application is used to add and configure messages and parameters on STANAG-3910
bus monitor modules.

Adding packages and parameters
Before running this application, ensure you have added a module that supports STANAG-3910 such as the
KAM/SBM/001. Otherwise, a “No Supported STANAG-3910 Parsers Found” message is displayed.
1. On the Applications menu, click STANAG-3910 Builder.

The STANAG-3910 Builder 3 dialog box opens.

2. To add a package to a link, select the link and then do one of the following:

 •  To add a single package, click Add Package.
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 •  To add multiple packages, type the number of packages in the Add Packages field and click Add 
Packages. (The maximum number of packages that can be added is shown in the Add Packages field.)

The packages are added. 

3. Change settings for each field as described in Table 27 on page 237.

4. To tag a package, select the package and then click the Tag Parameters tab.
Applicable tags for the selected package type are listed.

5. Select the parameters you want to add by clicking each parameter’s Enable check box. (Use the Ctrl key to 
select non-contiguous parameters.)

NOTE:  To add a single parameter, click the Enable check box twice and then skip the next 2 steps.
6. Press the F2 key to initiate edit mode on all selected rows.

7. Enable a check box and press the Enter key; all selected parameters are checked.
(Once selected, a tag can be renamed.)

8. Repeat steps 4 to 7 for other packages you want to tag.

9. To add parameters to a package, select the package and then do one of the following:
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 •  To add a single parameter to a package, click Add Parameter. 

 •  To add multiple parameters to a package, type the values you want in the Start Offset Word (the offset into 
the message where the first parameter is placed) and the Word Offset Increment (the offset between 
parameters in a message) fields, and then click Add Parameter. 

The parameters are added.

The Parameter Count indicates the number of parameters that have been added.

10. To add a data tag parameter to a payload parameter, select the parameter row and then click the Configure 
Tags button.

The following configure tags dialog opens.

11. Select the check box for the tag you want to enable and then click OK.

NOTE:  Only one check box can be enabled; that is, when you enable a second check box, the first is cleared. 
This is because you can only have one data time tag enabled: IRIGTime48 or TimeMicro.

12. Change the Parameter Name field if desired. 
The other fields cannot be changed in the STANAG-3910 Builder application.

13. To add a variant message to a package, select the package and then click the Variant Messages tab.
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14. Click the Add Variant button.
The variant message is added.

Table 27: Package settings

Setting Description

Instrument Name of instrument; read-only field.

Channel Name of channel; read-only field.

Package Name Each package added is assigned a default name with incrementing integer.

Number of Variants The number of variant or shared messages. These are messages stored in the 
same memory as an existing message. When a message has a payload param-
eter it can have variant messages attached to it. These variant messages can-
not be existing messages and they cannot have payload parameters. When a 
variant message is received it is stored in the same memory as its parent mes-
sage, that is, the message with payload parameters.

Physical Address The physical address of the message.

Destination Address The destination address of the message.

Payload count Number of parameters attached to the package.
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Removing packages and parameters
1. Select the link that you want to delete the package or parameter from.

2. Do one of the following:

 •  To remove a package:
Select the package (hold the Shift or Ctrl key to select multiple packages) and then click Remove 
Package. (Clear the Confirm Removal check box if you do not want to confirm deletion of packages.)
The packages and any attached parameters are removed.

 •  To remove a parameter:
Select the parameter (hold the Shift or Ctrl key to select multiple parameters) and then click Remove 
Parameter. (Clear the Confirm Removal check box if you do not want to confirm deletion of parameters.)
The parameters are removed.

NOTE:  When a parameter is being deleted, if that parameter has a time tag parameter associated with it, that 
is, there is an entry in the Time Tag column, then that time tag parameter is also deleted.

Exiting the application
• When you are finished adding and configuring packages and parameters, click Save & Close. 

The changes are saved to the configuration file.
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To see the packages and parameters, select the KAM/SBM/001 in the Navigator and then click the Packages tab.

EFABus-Express Builder
The EFABus-Express Builder application is used to add and configure messages and parameters on EFABus-
Express bus monitor modules.

Adding packages and parameters
Before running this application, ensure you have added a module that supports EFABus-Express such as the
KAM/SBM/101. Otherwise, a “No Supported EFABus-Express Parsers Found” message is displayed.
1. On the Applications menu, click EFABus-Express Builder.

The EFABus-Express Builder 3 dialog box opens.

2. To add a package to a link, select the link and then do one of the following:

 •  To add a single package, click Add Package.

 •  To add multiple packages, type the number of packages in the Add Packages field and then click Add 
Packages. (The maximum number of packages that can be added is shown in the Add Packages field.)



240    DAS Studio 3 User Manual (SW/BK/0015 | 13 Sep. 2021)

25

  

The packages are added. 

3. Change settings for each field as described in Table 28 on page 241.

4. To tag a package, select the package and then click the Tag Parameters tab.
Applicable tags for the selected package type are listed.

5. Select the parameters you want to add by clicking each parameter’s Enable check box. (Use the Ctrl key to 
select non-contiguous parameters.)

NOTE:  To add a single parameter, click the Enable check box twice and then skip the next 2 steps.
6. Press the F2 key to initiate edit mode on all selected rows.

7. Enable a check box and press the Enter key; all selected parameters are checked.
(Once selected, a tag can be renamed.)

8. Repeat steps 4 to 7 for other packages you want to tag.
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9. To add parameters to a package, select the package and then do one of the following:

 •  To add a single parameter to a package, click Add Parameter. 

 •  To add multiple parameters to a package, type the values you want in the Start Offset Word (the offset into 
the message where the first parameter is placed) and the Word Offset Increment (the offset between 
parameters in a message) fields, and then click Add Parameter. 
The parameters are added.

The Parameter Count indicates the number of parameters that have been added.

10. Change the Parameter Name field if desired. 
The other fields cannot be changed in the EFABus-Express Builder application.

11. To add a variant message to a package, select the package and then click the Variant Messages tab.

12. Click the Add Variant button.
The variant message is added.

.

Table 28: Package settings

Setting Description

Instrument Name of instrument; read-only field.

Channel Name of channel; read-only field.

Package Name Each package added is assigned a default name with incrementing integer.

Number of Variants The number of variant or shared messages. These are messages stored in the 
same memory as an existing message. When a message has a payload param-
eter it can have variant messages attached to it. These variant messages can-
not be existing messages and they cannot have payload parameters. When a 
variant message is received it is stored in the same memory as its parent mes-
sage, that is, the message with payload parameters.

Frame Control Refer to the EFABus Express standard.
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Removing packages and parameters
1. Select the link that you want to delete the package or parameter from.

2. Do one of the following:

 •  To remove a package:
Select the package (hold the Shift or Ctrl key to select multiple packages) and then click Remove 
Package. (Clear the Confirm Removal check box if you do not want to confirm deletion of packages.)
The packages and any attached parameters are removed.

 •  To remove a parameter:
Select the parameter (hold the Shift or Ctrl key to select multiple parameters) and then click Remove 
Parameter. (Clear the Confirm Removal check box if you do not want to confirm deletion of parameters.)
The parameters are removed.

NOTE:  When a parameter is being deleted, if that parameter has a time tag parameter associated with it, that 
is, there is an entry in the Time Tag column, then that time tag parameter is also deleted.

Exiting the application
• When you are finished adding and configuring packages and parameters, click Save & Close. 

The changes are saved to the configuration file.

Data Set Identification Refer to the EFABus Express standard.

Payload count Number of parameters attached to the package.

Table 28: Package settings (continued)

Setting Description
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To see the packages and parameters, select the KAM/SBM/101 in the Navigator and then click the Packages tab.

Importer applications
These applications are developed for customer-specific needs. For details, contact Curtiss-Wright support (acra-
support@curtisswright.com).
The following applications are described:
• “ARINC-NDO Importer” on page 243

• “Garmin HSDB Importer” on page 244

• “TTP Importer” on page 247

ARINC-NDO Importer
The ARINC-NDO Importer application is used to import ARINC-NDO bus definitions from a combination of two
CSV files.

Importing bus definitions
Before running this application, ensure you have added a module that supports ARINC-NDO messages such as
the KAD/EBM/103. Otherwise on import, a “No ARINC-NDO bus monitor instruments found in current
configuration” message is displayed.
1. On the Applications menu, click ARINC-NDO Importer.

mailto:acra-support@curtisswright.com
mailto:acra-support@curtisswright.com
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The ARINC-NDO Importer 3 dialog box opens.

2. Set the Importer Preferences (see the following table) that you want and then click Import.
A progress bar indicates import status and messages are written to the Message Server.
If the import fails, check the Message Server for details.

Garmin HSDB Importer
The Garmin HSDB Importer application is used to import data specified using the Garmin G1000 High Speed Data
Bus (HSDB) protocol into DAS Studio 3.

Importing Garmin HSDB Bus Data
Before running this application, ensure you have added a module that supports the Garmin HSDB Importer such
as the KAD/HBM/102. Otherwise on import, a “No Garmin HSDB bus monitor instruments found in current
configuration” message is displayed.

Table 29: ARINC-NDO Importer Preferences

Setting Description

Import packages with multi-
ple copies

Indicates whether or not message definitions in the CSV file with Max Copies 
greater than 1 are imported.

Import all subparameter defi-
nitions

Specifies whether all sub-parameter definitions found in the file are imported.

Remove existing links con-
nected to bus monitor chan-
nels

Specifies whether existing links on AFDX input channels are removed on 
import.

Generate unique prefix set-
tings where required

If required, specifies whether unique prefixes for imported bus definitions are 
generated and updates the corresponding prefix setting on the importer instru-
ment.

Stop import if parameter 
naming clash detected

Specifies whether import stops when a parameter naming clash is detected. By 
default newly imported parameters replace existing ones.

Stop import if package nam-
ing clash detected

Specifies whether import stops when a package naming clash is detected. By 
default newly imported packages replace existing ones.

Use smart import source 
finder

Specifies whether, when the specified CSV file location (specified via a setting 
on the importer module) is not present, the importer should look for this CSV file 
in the same location as the XidML configuration file.

Update input source location Specifies whether the importer, after finding the CSV file in the same location as 
the XidML configuration, should update the location setting/URL Algorithm on 
the importer module.
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1. On the Applications menu, click Garmin HSDB Importer.

The Garmin HSDB Importer 3 dialog box opens.

2. Set the Importer Preferences and Pipe ID settings (see the following table) that you want and then click 
Import.
A progress bar indicates import status and messages are written to the Message Server.
If the import fails, check the Message Server for details.
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Table 30: Garmin HSDB Importer Preferences and Pipe ID

Setting Description

Importer Preferences

Remove existing links con-
nected to bus monitor chan-
nels

Specifies whether existing links on AFDX input channels are removed on 
import.

Generate unique prefix set-
tings where required

If required, specifies whether unique prefixes for imported bus definitions are 
generated and updates the corresponding prefix setting on the importer instru-
ment.

Stop import if parameter 
naming clash detected

Specifies whether import stops when a parameter naming clash is detected. By 
default newly imported parameters replace existing ones.

Stop import if package nam-
ing clash detected

Specifies whether import stops when a package naming clash is detected. By 
default newly imported packages replace existing ones.

Use smart import source 
finder

Specifies whether, when the specified XML file location (specified via a setting 
on the importer module) is not present, the importer should look for this XML file 
in the same location as the XidML configuration file.

Update input source location Specifies whether the importer, after finding the CSV file in the same location as 
the XidML configuration, should update the location setting/URL Algorithm on 
the importer module.

Import payload parameters Specified whether the importer imports the subtypes under each packet in the 
Garmin HSDB XML file as parameters under each package in DAS Studio 3.

Pipe ID

Import A Pipe Import all HSDB packets specified under the A Pipe.

Import B Pipe Import all HSDB packets specified under the B Pipe.

Import C Pipe Import all HSDB packets specified under the C Pipe.

Import D Pipe Import all HSDB packets specified under the D Pipe.

Import D Debug Pipe Import all HSDB packets specified under the D Debug Pipe.

Import HSDB Manager Pipe Import all HSDB packets specified under the HSDB Manager Pipe.
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TTP Importer
The TTP Importer application is used to import TTP bus definitions from a CSV (comma separated values in a
standard text file format) file. Packages and parameters are created and attached to the selected KAD/TBM/101
(or other module that supports TTP messages) allowing the bus to be monitored.

Importing bus definitions
Before running this application, ensure you have added a module that supports TTP messages such as the
KAD/TBM/101. Otherwise on import, a “No TTP bus monitor instruments found in current configuration” message
is displayed.
1. On the Applications menu, click TTP Importer.

The TTP Importer 3 dialog box opens.

2. Set the Importer Preferences (see the following table) that you want and then click Import.
A progress bar indicates import status and messages are written to the Message Server.
If the import fails, check the Message Server for details.

Table 31: TTP Importer Preferences

Setting Description

Remove existing links con-
nected to bus monitor chan-
nels

Specifies whether existing links on TTP input channels should be removed by 
the importer

Generate unique prefix set-
tings where required

If required, specifies whether unique prefixes for imported bus definitions are 
generated and updates the corresponding prefix setting on the importer instru-
ment.

Stop import if parameter 
naming clash detected

Specifies whether import stops when a parameter naming clash is detected. By 
default newly imported parameters replace existing ones.

Stop import if package nam-
ing clash detected

Specifies whether import stops when a package naming clash is detected. By 
default newly imported packages replace existing ones.

Use smart import source 
finder

Specifies whether, when the specified CSV file location (specified via a setting 
on the importer module) is not present, the importer should look for this CSV file 
in the same location as the XidML configuration file.

Update input source location Specifies whether the importer, after finding the CSV file in the same location as 
the XidML configuration, should update the location setting/URL Algorithm on 
the importer module.
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Other applications and tools
The following applications and tools are available:
• “Quicklook” on page 248

• “Power Calculator” on page 250

• “Serial Number Synchronizer” on page 251

• “X-Report” on page 255

Quicklook
Quicklook is a software tool for real-time visualization and analysis. It is a data view package for single users,
intended primarily for lab-bench or pre-flight testing. It allows data to be viewed on user-defined displays using an
independent output format for each parameter viewed.
Quicklook can be run from either the Applications menu or the Navigator.

Running Quicklook from the Applications menu
1. Ensure connected hardware has power and the configuration file is open.

2. On the Applications menu, click Quicklook.

3. Choose a Data Source and Package and click OK.

The IADS setup wizard appears.

4. Follow the prompts in the wizard and click Next.

5. For detailed help, go to Start -> All Programs -> IADS -> IADS Help System.
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Running Quicklook from the Navigator
When run from the Navigator, Quicklook is context sensitive. For example, if you run it on an Ethernet link,
Ethernet is automatically defined as the Data Source; if you run it on a PCM link, SamDec is automatically defined
as the Data Source.
1. Ensure connected hardware has power and the configuration file is open.

2. Right-click on the appropriate link and click Quicklook.

The IADS setup wizard appears.

3. Follow the prompts in the wizard and click Next.

4. For detailed help, go to Start -> All Programs -> IADS -> IADS Help System.
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Power Calculator
The Power Calculator allows users to review the power usage for each chassis in their system. It shows the power
consumed by each module in the chassis, for each voltage rail. It also shows the totals for each voltage rail and a
percentage of how much of the available power is being consumed.

Running Power Calculator
1. On the Applications menu, click Power Calculator. 

The Power Calculator dialog box opens. (See the following table for descriptions of the dialog fields.)

2. Review the power consumption for each chassis shown on the left-hand side of the window. 

3. Click Generate Report to generate a HTML report of the current power usage. 

NOTE:  Power Calculator does not calculate power consumed by external excitation.

When power utilization exceeds 50%, a warning is displayed; when it exceeds 70%, an error is displayed.

Table 32: Power calculator dialog box settings

Setting Description

Chassis Selection The list of chassis in the system that Power Calculator can provide data for.

Module Name The names of the user modules in the selected chassis.

xV (mW) The columns displaying the calculated data for each voltage rail in the selected chassis.

Generate Report Generates a HTML report corresponding to the data shown in the window.
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Serial Number Synchronizer
Serial Number Synchronizer verifies and updates the configuration's serial numbers from hardware. This occurs in
two operations: Read Hardware and Synchronize.
The Read Hardware operation searches for the hardware defined in the configuration file. The discovered serial
number is displayed along with the module's state (displayed in the Hardware State column). A module may be
classed as missing, of a different type, or of having a different serial number. Modules discovered during read but
not defined in the configuration are displayed as unused modules.

NOTE:  If Serial Number Synchronizer discovers a module that is not defined in the configuration file, then you must 
run Calibration Fetcher. This ensures internal calibration from the module is taken into account during pro-
gramming. See “Using Calibration Fetcher” on page 85.

Synchronization is only allowed after the hardware has been read and one or more serial numbers can be updated.
A serial number is only updated when the part reference in the configuration file matches the discovered part
reference. If the discovered part reference does not match, the hardware state displays the discovered part
reference. Running Serial Number Synchronizer
1. On the Applications menu, click Serial Number Synchronizer.

The Serial Number Synchronizer dialog box opens. (See the following table for descriptions of the dialog 
fields.)

2. Click Read Hardware. 
All discoverable hardware is searched for and each module's state is displayed in the Hardware State column. 

3. Click Synchronize. (Synchronize is only enabled after reading hardware and when one or more module serial 
numbers can be updated.)
Missing and conflicting serial numbers in the configuration are resolved.

4. Click Generate Report. 
Generates a CSV report file describing the present state of the configuration table. The report can then be 
imported into a spreadsheet application.

5. Click Open Find Bar. 
A Find text search field appears at the top of the window, which allows you to search the configuration file for 
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text you specify. All columns are searched.

Status information bar
The status information bar in the bottom-left of the screen indicates the status of the configuration. For example,
the following status indicates modules are not found.

Figure 82: Information bar with modules missing

Table 33: Serial Number Synchronizer dialog box settings

Setting Description

Chassis Acra KAM-500 DAU or SSR recorder

Identification IP address or DAU identification number for chassis

Slot User slot number

Module Name of the Acra KAM-500 DAU, SSR recorder, or module

Part Reference Acra KAM-500 DAU, SSR recorder, or module's part reference

Expected Serial Number Module's serial number in the configuration

Discovered Serial Number Serial number read from hardware

Hardware State Displays the module state; updated after reading and synchronizing

Read Hardware Searches for the configuration hardware and updates the hardware state

Synchronize Updates the serial numbers in the configuration

Generate Report Generates a CSV report for the present state of the configuration table

Open find bar Provides text search functionality for the configuration table
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Example of Serial Number Synchronizer with and without errors

Figure 83: Initial system with no serial numbers

Figure 84: Initial system with serial numbers

Table 34: Status information bar

Color Description

Green Module synchronized without errors or warnings

Yellow Module not found

Red Indicates an error, such as module has no serial number or different part reference found
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Figure 85: System has been read

Figure 86: System synchronized without errors

Figure 87: System synchronized with several errors
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Errors when running Serial Number Synchronizer
You may see an error message as shown in the following table while running Serial Number Synchronizer. 

X-Report
X-Report generates reports from XidML 3.0 files using XSLT stylesheets. X-Report offers the following report
generation options: Inventory, Parameters, XidML 3.0 File Viewer and Others. 
The Inventory option allows the generation of inventory reports from XidML 3.0 files, listing the hardware with serial
numbers. 
The Parameters option allows the generation of reports from XidML 3.0 files, listing all parameters within a task.
The XidML 3.0 File Viewer option allows the generation of reports from XidML 3.0 files, listing all XidML file
features including instruments, modules, parameters, and setting’s links. 
The Others option lets you choose a user-defined stylesheet to generate bespoke reports.

Figure 88: X-Report dialog box

Using X-Report 
1. On the Tools menu, click X-Report.

Table 35: Serial Number Synchronizer error messages

Error message Description/solution

No configuration loaded A configuration file is not open. 
Open a configuration file and run Serial Number Synchronizer again.

MyKAM_CHS_13U is missing a con-
troller

A controller module for the chassis is not detected. 
Ensure a controller is added and run Serial Number Synchronizer 
again.

MyKAM_CHS_13U, 
MyKAM_CHS_13U_1 are missing 
controllers

If a single DAU has a controller, Serial Number Synchronizer still runs 
but only the DAU with the controller is displayed in the configuration 
table. 
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The X-Report Tool dialog box appears.

2. Click the browse button next to the Task field and then browse to select the XidML task file you want.

3. Select a Report Type from the drop-down menu.

 •  Inventory - Lists the module names, serial numbers, module types and slots for each DAU in the XidML 3.0 
input file.

 •  Parameters - Lists parameters and their units, data format, range and source.

 •  XidML 3.0 File Viewer - Lists instruments, module location, parameters, and setting’s links in a bullet point 
tree view.

 •  Others - Selecting Others allows an alternative stylesheet to be used when generating the report.

4. Select the desired Verbosity Results radio button.

 •  High - generates all messages

 •  Medium - generates Errors and Warnings

 •  Low - generates Errors

5. Click OK to generate the report.
The Report Creation dialog appears.
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6. Click OK to view the report.
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Chapter 26
REVISION HISTORY

Date Action

13 Sep. 2021 In Chapter 1, Overview of the DAS Studio 3 interface, increased the minimum recom-
mended RAM to 8 GB. In the two-page screen overview spread, added X-Report icon 
and description to the Tool menu screen.
In Chapter 14, Packages tab, under “Placing single parameters”, step 2, added the con-
dition that the frame shape only allows multipliers of 2 and 5.
In Chapter 25, Applications, added a new “X-Report” section.

9 Jun. 2021 In Chapter 14, Packages tab, under “Control how parameters are split across transmis-
sion words” specified that the split fragment is displayed as colon-delimited.
In Chapter 25, Applications, added a new “Renaming multiple packages or parameters”; 
added a new “STANAG-3910 FCS Bus Builder” section.
In Table 25: Package settings, added a note for Start Sequence and Stop Sequence set-
tings clarified that the sequence of characters needs to be taken into account.

15 Apr. 2021 In Chapter 2, Options, Figure 1 and figure under “Program and Verify” updated screens 
and description to show Run Validation.
In Chapter 6, Program, under “Using Verify and Program” updated screen to show Run 
Validation.
In Chapter 13, Settings tab, replaced multiple screens to show channel name or link 
name over each port button.
In Chapter 14, Packages tab, replaced multiple screens to show update Transmission 
Assistant toolbar, which now shows four extra buttons for persistent placement prefer-
ence storage; while the smart placement button is beside the PCM package builder but-
ton. In section “Creating a PCM discrete parameter” deleted the note after step 6.
In Chapter 15, Processes tab, in the first sentence added “that are not configurable in 
their builder applications, see Chapter 25”. In step 1 of “Reading package tags” section, 
changed text to read “When an instrument does not have a bus monitor builder applica-
tion and there are no parsers defined on a channel or instrument, a general add parser 
button is displayed. In bus monitor builder applications, parsers are configured in param-
eter's Tag Parameters tab (see “Builder application GUI overview” on page 190.)”. 
Replaced multiple screens to only show catch-all parsers.
In Chapter 25, Applications, under “Ethernet Builder” section “Adding frames and param-
eters” replaced the screen at step 3, as a new “Parameter Size In Bits” button has been 
added; steps modified accordingly.

8 Dec. 2020 In Chapter 2, Options, Updated “Run MCS” description on the “Program and Verify” 
screen. Added description and screen for new Instruments Import tool.
Added new “Importing Options settings from a previous DAS Studio installation” section.
In Chapter 18, Instruments Palette added a new section “Using the XDefML Instrument 
Import tool”.
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28 Sep. 2020 In Chapter 2, Options, updated multiple “Options” screens.
In Chapter 3, Example, in the “Setting up a KAD/EBM/102...” section, added a Note at 
step 10, and updated the screen shot at step 13.
In Chapter 6, Program, under “Using Verify and Program” added information for compil-
ing and verifying using parallel compilation.
In Chapter 7, IP Address Programmer, under “Using IP Address Programmer” added a 
Note on using multiple active Ethernet ports.
In Chapter 10, Bridge Balancer 3, under “Supported analog modules” added 
AXN/ADC/401 module.

7 Jul. 2020 In Chapter 2, updated the “Options” screen to add “Add link to packages and parame-
ters” and “Use ARI/001/B link settings”. Under “Settings Tab” added a Note for the cus-
tom UI for the KAD/ADC/136.
In Chapter 14, updated screens and procedures for the Can Place function. Added the 
new “Locking/unlocking parameters” and “Persistent Setting” sections. 
In Chapter 18, in the “Adding a bus or a subset of parameters from a bus” section added 
a Note for the KAD/ARI/001/B link import functionality.
In Chapter 25, in the “Parsing RS messages in hexadecimal and binary format” section, 
added a Note to clarify Serial Builder support for wild cards.

12 Feb. 2020 In Chapter 3, Example, in the “Network to legacy PCM programming” section added a 
Note to clarify when using a legacy PCM system over Ethernet.
In Chapter 4, Discover, updated screens and procedures to show an “Expected Gate-
ways” option in place of the previous “Auto-detect IP Addresses of Ethernet devices that 
support SNMP” check box.
In Chapter 6, Program, in the “Errors when verifying or programming instrumentation” 
section added an additional description and screen for a new Error dialog, which shows 
missing devices.
In Chapter 25, Applications, added a new “EFABus-Express Builder” section.
In the “MIL-STD-1553 Builder” section, updated some screens and descriptions to 
address the new Variant Messages function.
In the “STANAG-3910 Builder” section, updated some screens and descriptions to 
address the Tag Parameter and the new Variant Messages function.

14 Mar. 2019 In Table of Contents, added chapter numbering.
In Chapter 7, IP Address Programmer added section for newly-supported Axon Family 
Chassis protocol.
Added this Revision history section to the User Manual.

30 Nov. 2018 In Chapter 4, Discover, updated screens which previously showed “Auto-detect IP 
Addresses” to “Auto-detect IP Addresses of Ethernet devices that support SNMP”; all 
occurrences of same text were also updated.

24 Sep. 2018 In Chapter 2 - Options, added descriptions for new features “iNET-X Package Defaults” 
“Import”, and “Settings Tab”; removed last item “UniqueIDsForMemoryPackages” from 
MCS.
In Chapter 4 - Discover, updated all procedures due to the new “Auto-Detect IP 
Addresses” feature.
In Chapter 18 - Instruments Palette, expanded the “Customizing the library pane” sec-
tion.
In Chapter 25 - Applications, in the “Serial Builder” application, Table 22: updated the 
description for Parsing Mode.

Date Action
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13 Jun. 2018 In Chapter 25 - Applications, in the “Builder application GUI overview” section, intro-
duced the new Tag Parameters tab.
Updated all bus monitor applications, which use the Tag Parameters tab including the fol-
lowing: 
“ABI/ACE-CCDL/ACB Serial Builder”
“Builder application GUI overview” 
 “ABI/ACE-CCDL/ACB Serial Builder” 
 “ARINC-429 Builder” 
 “FireWire Builder” 
 “CAN-Bus Builder” 
 “Ethernet Builder” 
 “IMB Serial Builder” 
 “MIL-STD-1553 Builder” 
 “Serial Builder” 
 “STANAG-3910 Builder”

5 Apr. 2018 Under Supported operating systems, removed support for Windows XP; added support 
for Windows 10.
In Chapter 13 - Settings tab, added new Packetization Sink and Packetizer Format sec-
tions. In Chapter 14 - Packages tab, in the Creating a PCM discrete parameter section, 
reversed the order of steps 6 and 7; added a note to step 6 to clarify creating a discrete 
parameter.

20 Sep. 2017 Added new Options chapter to explain expanded Options dialog box. Added new section  
in Applications chapter for STANAG-3910 Builder application.

30 Mar. 2017 In “Supported character set” section, added ampersand to list.
In “Packages tab” chapter, added descriptions for keyboard shortcuts.
Added new chapter for Parameter search tool.

22 Dec. 2016 In chapter 2, added following new sections: “Reading asynchronous PCM data”; “Net-
work to legacy PCM programming”; and “Setting up a KAD/EBM/102 to parse automati-
cally generated packets from the Multi-Chassis Scheduler (MCS)”.
In chapter 5, added new “Programming options” section.
Added new “Chapter 6, IP Address Programmer” section.
In chapter 12, added new “Filtering on KAD/SWI/108 and NET/SWI/101/C” and “Cross 
Point filtering” sections.

16 Jun. 2016 Chapter 1: Added “Supported character set” section.
Chapter 2: Reworked chapter so as to separate PCM and Ethernet information work 
flows. 
Chapter 12: Added additional sections for PCM. Reworked so as to separate PCM and 
Ethernet information work flows.
Chapter 21: New “Time Seeder” chapter.
Chapter 22: In Applications chapter, added “IMB Serial Builder”, “Power Calculator” and 
“Serial Number Synchronizer” sections.
Chapters containing Palettes: “Copying rules” and “Add With Connections” functionality 
updated.

28 Apr. 2014 In Calibration Fetcher chapter, clarified Note, and changed same from Note to Warning. 
In Package Generator chapter, added description for INET / IENA to table 2. In Settings 
tab chapter, added new Port routing setup for switch modules section. Added new chap-
ter to cover Algorithms tab. Applied Curtiss-Wright template features.

Date Action
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